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About This Guide

This document provides information on known issues for the initial release of NetWare® 6.5. The 
issues are divided into sections based on product features. Use the Table of Contents or the online 
Search feature to locate the information you need.

For information about additional issues discovered after the initial release, access the Novell® 
KnowledgeBase (http://support.novell.com/search) and enter TID# 10084514.

Additional Documentation

For complete information on setting up and using NetWare 6.5, see the NetWare 6.5 online 
documentation (http://www.novell.com/documentation/lg/nw65).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as UNIX*, should use forward slashes as required by your software.
About This Guide 7

http://support.novell.com/search
http://support.novell.com/search
http://support.novell.com/search
http://www.novell.com/documentation/lg/nw65
http://www.novell.com/documentation/lg/nw65


Novell Confidential 00_preface.fm last saved  8/25/03 Manual Version: 3/17/03103
8   NetWare 6.5 Readme



Manual (ENU) 3/17/03103Novell Confidential overview.fm last saved  8/25/03
1 General Information

NetWare 6.5 Contents

The NetWare 6.5 product package includes the following:

NetWare 6.5 CD 1 (Operating System)

NetWare 6.5 CD 2 (Products)

NetWare 6.5 Demonstration Kit (Digital Airlines)

NetWare 6.5 Documentation CD

NetWare 6.5 License/Cryptography diskette

NetWare 6.5 Overview and Installation Guide

NetWare 6.5 Partner CD

Novell DirXML Starter Pack CD

Novell Nterprise Branch Office CD

Novell Clients Software CD

The Clients CD includes the following:

Novell ClientTM 4.9 for Windows* NT*/2000/XP

Novell Client 3.4 for Windows 95/98

Novell ConsoleOne® 1.3.6 with NetWare 6.5 snap-ins

Novell NetDrive Client 4.1

Novell Modular Authentication Services (NMASTM) Client 2.2

Client NICI 2.6 for Windows

exteNdTM WorkbenchTM 4.1.1

exteNd Client 5.0

NetIdentity Agent 1.2

Java Runtime License

NetWare 6.5 comes with the JavaTM 2 Runtime Environment (J2RE) Standard Edition, version 
1.4.1_x. This product includes code licensed from RSA Security, Inc. Some portions licensed from 
IBM* are available at the International Components for Unicode for Java Web site (http://
oss.software.ibm.com/icu4j/).
General Information 9
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Product Documentation Updates

The documentation on the CD that ships with the NetWare 6.5 package is current as of July 1, 
2003. The NetWare 6.5 online documentation (http://www.novell.com/documentation/lg/nw65) is 
the most current source and will continue to be updated.

Browser Support in NetWare 6.5

We have tested certain platforms and browser versions for the NetWare 6.5 user and administrative 
interfaces. For detailed information about the browser support included in NetWare 6.5, see the 
NetWare 6.5 Administration Overview.

For Additional Information

For information about additional issues discovered after the initial release of NetWare 6.5, see the 
Novell KnowledgeBase (http://support.novell.com/search) and enter TID# 10084514.
10   NetWare 6.5 Readme
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2 Interoperability Issues

Novell Products Supported on NetWare 6.5

Upgrades and new installations of the following Novell® products are supported on NetWare® 6.5:

DirXML® 1.1a

iFolder 2.x

GroupWise® 6.0 Support Pack 3
NOTE: The WebAccess servlet is supported only on an upgrade. Support for the WebAccess servlet on 
a new installation will be available with GroupWise 6.0 Support Pack 4. 

GroupWise 6.5 Support Pack 1

NetMailTM 3.1

NterpriseTM Branch OfficeTM 1.0

SecureLogin 3.0.4

ZENworks® for Desktops 4.01/ZENworks for Desktops 4 Support Pack 1
IMPORTANT: You will need to apply the latest ZENworks for Desktops update in order to have this 
support. See the ZENworks for Desktops Readme (http://www.novell.com/documentation/lg/zdpr/
readme/readme-zfd401-nw65update.html) for information about obtaining the update and other 
information about using ZENworks for Desktops with NetWare 6.5.

ZENworks for Servers 3.02/ZENworks for Servers 3 Support Pack 2
IMPORTANT: You will need to apply the latest ZENworks for Servers update in order to have this 
support. See the ZENworks for Servers Readme (http://www.novell.com/documentation/lg/zfs302/
readme/readme_zfs302_update_nw65.html) for information about obtaining the update and other 
information about using ZENworks for Servers with NetWare 6.5.

Novell Products Not Supported on NetWare 6.5

Upgrades and new installations of the following Novell products are not supported with the initial 
release of NetWare 6.5. 
NOTE: Products marked with a double asterisk will be supported on NetWare 6.5 in their next release.

BorderManager® 3.7**

exteNdTM Director Standard Edition 4.1**

GroupWise 5.5

GroupWise Snap-ins for ConsoleOne**

iChain® 2.1 Support Pack 1**

iChain 2.2

ManageWise® 2.7
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ZENworks for Desktops 3.2 Support Pack 2

ZENworks for Handhelds 5.1**

ZENworks OnDemand ServicesTM 2.0

Third-Party Issues 

For a description of third-party issues with NetWare 6.5, see Chapter 44, “Third-Party Adapters, 
Drivers, and Applications,” on page 113.

ZENworks for Desktops Management Agent and NetIdentity Agent Not Compatible

Co-existence of the ZENworks for Desktops Agent and NetIdentiy client is not supported in this 
release. Upgrading to the NetIdentity client from the ZENworks for Desktops Management Agent 
is also not supported.

The ZENworks for Desktops Management Agent links into the browser installed on the 
workstation. It also installs supporting files to provide ZENworks for Desktops functionality 
whether using the MidTier or Novell ClientTM. When the Agent is installed on the workstation and 
Internet Explorer is used to access NetIdentity-enabled Web services such as Virtual Office or 
iManager on NetWare 6.5, the browser will crash during or after authenticating to the Web service.

If ZENworks for Desktops functionality is not needed, you can remove the ZENworks for 
Desktops Management Agent and install the NetIdentity client from the Novell Clients Software 
CD that ships with NetWare 6.5. This will provide the automatic authentication it was designed 
for, but at the loss of Workstation Inventory, Application Launcher, etc. 

GroupWise WebAccess Installation on NetWare 6.5

The default installation of GroupWise WebAccess on a NetWare 6.5 Web server will result in 404 
Web browser errors when trying to log in to GroupWise WebAccess (http://server_address/servlet/
webacc) or GroupWise WebPublisher (http://server_address/servlet/webpub). 

To resolve this issue: 

1 Install GroupWise 6.5 WebAccess or GroupWise 6 Support Pack 3 WebAccess.

During the installation, make sure you install the WebAccess Application and the 
WebPublisher Application (optional) to the Apache directory (sys:\apache2) and the Tomcat4 
root directory (sys:\tomcat\4). The Tomcat path should be detected automatically. 

2 After the installation is complete, open the sys:\tomcat\4\webapps\root\web-inf\web.xml file.

The file contains <servlet> entries for WebAccess (webacc) and Novell Spell Checker 
(spellchk). If you installed WebPublisher, it also contains a WebPublisher <servlet> entry 
(webpub).

3 Locate the last </servlet> tag, then add the following servlet mapping information between 
the </servlet> tag and the </web-app> tag:

<servlet-mapping>
<servlet-name>webacc</servlet-name>
<url-pattern>/servlet/webacc/*</url-pattern>

</servlet-mapping>
<servlet-mapping>

<servlet-name>spellchk</servlet-name>
<url-pattern>/servlet/spellchk/*</url-pattern>

</servlet-mapping>
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If WebPublisher is installed, also add the following information to the same location:

<servlet-mapping>
<servlet-name>webpub</servlet-name>
<url-pattern>/servlet/webpub/*</url-pattern>

</servlet-mapping>

4 Save and exit the web.xml file.

5 Stop and restart Tomcat4 (or restart the server).

6 Make sure the GroupWise WebAccess Agent, Message Transfer Agents, and Post Office 
Agents are running.

7 Log in to GroupWise WebAccess to verify that WebAccess is functioning properly.

NetWare 6.5 Upgrade after GroupWise WebAccess Installation

When you upgrade to NetWare 6.5 on a server where GroupWise WebAccess is installed, the 
NetWare 6.5 installation program updates the WebAccess configuration files (webacc.cfg, 
spellchk.cfg, and webpub.cfg in the novell\webaccess directory on the root of the Web server). It 
changes Tomcat 3.3 references to Tomcat 4. 

For example, it changes references to the Tomcat\33 directory to the Tomcat\4 directory. However, 
it does not make changes to the WebAccess objects in the eDirectoryTM tree because there is no 
convenient way to determine where the WebAccess objects are located in the tree. Therefore, you 
must manually change the Tomcat version information on the WebAccess objects. 
IMPORTANT: If you do not manually update the Tomcat information on the WebAccess objects and you 
subsequently edit the WebAccess configuration information in ConsoleOne, ConsoleOne® will overwrite the 
configuration files that were updated by the NetWare 6.5 installation program with obsolete Tomcat information 
and WebAccess will stop working.

1 In ConsoleOne, browse to and right-click the WebAccess Application object 
(GroupWiseWebAccess), then click Properties.

2 Click Application > Templates.

3 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.

4 Right-click the Speller Application object (NovellSpeller), then click Properties.

5 Click Application > Environment.

6 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.

7 If you have installed WebPublisher, right-click the WebPublisher Application object 
(GroupWiseWebPublisher), then click Properties. 

8 Click Application > Templates.

9 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.
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3 Installation/Upgrade

For complete instructions on installing NetWare® 6.5, see the NetWare 6.5 Overview and 
Installation Guide.

Conditions for Installing NetWare 6.5

The NetWare 6.5 installation is supported only under the following conditions:

Install onto a clean, error-free disk drive.

Remove files from any previous installation, then run the SCANDISK or CHKDSK DOS 
utilities to verify the integrity of the DOS partition.

Install a NetWare 6.5 server into a tree that has Novell® eDirectoryTM 8 or later. 

Installing into a tree with a version earlier than eDirectory 8 can make User objects 
unmanageable when using management utilities other than those that ship with NetWare 6.5.

The server cannot be installed in a tree that contains NetWare 4.10 servers. All servers in the 
tree must be NetWare 4.11 or later.

To ensure that Licensing works properly, all NetWare 4 and 5 servers in your tree must be at 
the following minimum Support Pack level:

NetWare 4.11 and 4.2 servers—Support Pack 6a or later
NetWare 5.0 servers—Support Pack 4 or later
NetWare 5.1 servers—Support Pack 3 or later
NOTE: We recommend installing the latest available Support Packs on all NetWare servers in your tree.

Before you introduce a NetWare 6.5 server into an existing network, you must run the 
NetWare Deployment Manager to update the network. 

See Preparing the Network with Deployment Manager in the NetWare 6.5 Overview and 
Installation Guide for more information.
IMPORTANT: The NetWare 6.5 Deployment Manager can be run only in an Internet Explorer 5 or 6 
browser.

Interoperability with Other Novell Products

For a description of interoperabiity issues between this release and other Novell products, see 
Chapter 2, “Interoperability Issues,” on page 11.

Upgrading from NetWare 5.1

Upgrading to NetWare 6.5 from NetWare 5.1 Support Pack 6 and eDirectory version 8.5 is not 
supported. The minimum eDirectory level required to upgrade to NetWare 6.5 is eDirectory 
version 8.6.

Upgrading to NetWare 6.5 from NetWare 5.1 running NDS® 7 is supported, providing that 
Deployment Manager is first run to prepare the network for the new NetWare 6.5 server.
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Slow File Copy over a WAN Link During a Remote Upgrade

When you run a remote upgrade, if the source files are located on a remote server, that server must 
contain a DS replica in order for the server-to-server file copy to run efficiently. If a replica does 
not exist on the source server, the file copy might revert to a workstation copy, which can be 
significantly slower over a WAN link.

Installing a NetWare 6.5 Server into a Pure NetWare 4.x eDirectory Tree

To install a NetWare 6.5 server into a pure NetWare 4.x tree, run the NetWare Deployment 
Manager utility and follow the directions to copy updated NetWare 4.x NDS files to the network, 
generate GUIDs, and update the schema. 

After running the Deployment Manager, but before attempting to install the NetWare 6.5 server, 
do the following:

1 Run DSRepair on a server that holds a writable copy of the Root partition.

2 Select Advanced Options Menu > Global Schema Operations.

3 Log in as the Admin, if necessary, then run the Post NetWare 5 Schema Update.

4 After the Post NetWare 5 Schema Update completes, return to the main menu and select 
Advanced Options Menu > Repair Local DS Database.

5 Set the Rebuild Operational Schema option to Yes.

6 Run the local database repair.
NOTE: These steps are necessary only in a pure NetWare 4.x tree. If any NetWare 5.1 or NetWare 6.0 servers 
already exist in the tree, this procedure is not necessary.

Using Updated Files during the Installation

The c:\nwupdate directory structure for NetWare 6.5 mirrors the directory structure of the install 
image. Updated files should be placed in the c:\nwupdate subdirectory that corresponds to where 
they are located in the install image. 

There are two notable exceptions to this rule:

1. Install scripts (sys_inst.ils, dos_inst.ils, defpre.ils, defcopy.ils, etc.) should be placed in the 
c:\nwupdate directory.
NOTE: Defpre.ils and defcopy.ils are dummy scripts called from dos_inst.ils (the first C-worthy copy) and 
sys_inst.ils (the second C-worthy copy), respectively, and are intended to be modified for OEM use. 
These scripts are also used in NetWare 6.0.

2. The subdirectories of the c:\nwupdate\drivers directory have been eliminated (\storage, \lan, 
\psm, \sbd, \cios). Their files and subdirectories should be placed in the c:\nwupdate\drivers 
directory.

There is a blackout period during the install when access to the DOS drives (C:, D:, etc.) is 
prohibited. This occurs during the time that platform support and storage drivers (PSMs, HAMs, 
SBDs, and CDMs) are detected and loaded. However, they can be loaded from a floppy disk.

Unable to Log in during Concurrent Installations

If you attempt to install a new server into your tree at the same time you upgrade another server in 
the tree to NetWare 6.5, you might have difficulty logging in to the server being upgraded until the 
other server’s installation is complete.
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NetWare 6.5 Installation with Existing Volumes

If you install NetWare 6.5 on a server with existing NSS or traditional volumes, the install will not 
create eDirectory objects in the tree for the existing volumes. You must mount the pre-existing 
volumes, then create an eDirectory object for each volume.

To create an eDirectory object for an NSS volume using iManager:

1 Launch iManager on your workstation.

2 In the left-hand navigation frame, click the Plus sign (+) next to the Storage heading.

3 Click the Volumes link under the Storage heading.

The existing volumes for the server are displayed in the Volume Management frame of the 
iManager screen.

4 Select the volume you want to create an eDirectory object for.

5 To mount the existing volume, click the Mount link in the Volume Management frame of 
iManager.

6 To create an eDirectory object for the volume, click the Update eDirectory link in the Volume 
Management frame of iManager.

To create an eDirectory object for an NSS volume using NSSMU:

1 Enter load nssmu at the server console.

2 Select Volumes, then press Enter.

3 Select the Volume that needs to have an eDirectory object created for it.

4 To update eDirectory with the new Volume object, press F8 > Alt F8.

To create an eDirectory object for a traditional volume using NetWare Remote Manager:

1 Launch NetWare Remote Manager on your workstation.

2 In the left-hand navigation frame, click the Partition Disks link under the Manage Server 
heading.

3 In the right-hand frame of the browser window, locate the volume you want to create.

4 Click the Create eDir Object link next to the desired volume.

The Create eDir Object link disappears after the object is created.

Running the Deployment Manager Utilities without a Browser

The Internet Explorer version 5 or 6 browser is required for Deployment Manager to work 
properly. 

If you do not have Internet Explorer installed on the workstation where the Deployment Manager 
is running, or you do not want to use the ActiveX Control included with Deployment Manager, 
then search for TID# 10084103 in the Novell Knowledgebase (http://support.novell.com/search/
kb_index.jsp) for information about running the Deployment Manager utilities without a browser.
Installation/Upgrade 17
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Deployment Manager Disk Space Requirement

In order to run the Deployment Manager, you must have a minimum of 67 MB of disk space for 
the JRE and Installation files.

If you receive an error stating that rt.jar or ni.jar is not in your class path, it means the system ran 
out of disk space. Delete the c:\program files\common files\novell\jre and c:\program 
files\common files\novell\nis30 directories, recheck your disk space, then run the Deployment 
Manager again.

Callwin.dll Errors When Running the Deployment Manager

When attempting to run the Deployment Manager, if you receive an error specifying that you need 
calwin.dll, it means that you do not have the Novell ClientTM installed. Install the Novell Client, 
then run the Deployment Manager again.

Remote Installation/Upgrade

After the initial reboot during a remote upgrade, a login screen might display requiring you to log 
in to the server being upgraded. If this occurs, provide the login information, click Details, type 
the IP address of the server being upgraded, then click OK.

If Installation/Upgrade tasks fail to run from iManager, you might need to change your security 
settings.

1 In Internet Explorer, click Tools > Internet Options.

2 Click Security > Custom Level.

3 Click the Enable radio button under Initialize and Script ActiveX Controls Not Marked as 
Safe.

4 Click OK.

WAN Boards Don’t Load during a NetWare 6.5 Upgrade

WAN boards don’t load after the server reboots following the initial file copy during an upgrade 
to NetWare 6.5. This is a problem if the server needs the WAN board loaded to complete the 
upgrade to NetWare 6.5. This occurs with all supported NetWare platforms using WAN boards.

To load the boards manually, enter reinitialize system at the server console. 

To automatically load the boards during the installation, add defupgrd.ils to the c:\nwupdate 
directory of the server being upgraded. Defupgrd.ils must contain the Reinitialize System 
command to load the WAN boards. Add the following text to defupgrd.ils:

@Fileset

 Description: "Default Upgrade Modules"

   Name:   DefUpgrade_Files

   Class:  MANDATORY

   Bytes:  0

   DiskBytes:  0

console ’Reinitialize System’, 2

@EndFileset
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After the upgrade has completed and the server starts, the WAN boards load normally.

Before Doing a Post Install of Virtual Office or NetStorage
IMPORTANT: Failure to follow these steps could cause the Apache configuration file 
(sys:\apache2\conf\httpd.conf) to be left empty or incomplete.

Before doing a local post install of NetStorage or Virtual Office at the server, comment out the PSA 
line in autoexec.ncf and reboot the server. After the post-install is complete, remove the comment 
from the PSA load line in autoexec.ncf. (This issue has only been seen on a post-install done at the 
server. The remote post-install does not have this problem.)

If you have already done a post-install of NetStorage or Virtual Office and have found the 
httpd.conf file to be incomplete, restore the httpd.conf file from a backup. 

If a backup does not exist, comment out the PSA line in autoexec.ncf, reboot the server, and then 
post-install the following all at the same time: Apache, NetStorage or Virtual Office and any other 
products that are dependent on Apache which were previously installed.

Missing Information in the Non-English Documentation

Due to translation deadlines, two installation screens are not documented in the non-English 
versions of the NetWare 6.5 Overview and Installation Guide. The two screens are related to 
Novell NsureTM Audit. For English language documentation of these screens, see Novell Nsure 
Audit Starter Pack - Component Selection in the NetWare 6.5 Overview and Installation Guide.

Incorrect Upgrade Scenarios in the Non-English Documentation

The non-English versions of the NetWare 6.5 Overview and Installation Guide contain a statement 
that indicates upgrades to NetWare 6.5 are supported from NetWare 4.2 and 5.0. These upgrade 
paths have not been adequately tested and are, therefore, not supported in this release. (The 
statement has been removed from the English version of the documentation.)
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4 NetWare Migration Wizard 6.5

For additional issues related to NetWare® Migration Wizard, see the Readme (http://
www.novell.com/documentation/lg/migwiz65/readme.txt) located with the NetWare Migration 
Wizard online documentation.

Installing Tomcat and exteNd Application Server after the Migration

After completing a NetWare 6.5 to NetWare 6.5 migration using the Migration Wizard, complete 
the following steps to ensure that Tomcat installs correctly:

1 Copy sys:\sys.mig\java to sys:\java, overwriting all existing files.

2 Copy sys:\sys.mig\adminsrv to sys:\adminsrv, overwriting all existing files.

3 Copy sys:\sys.mig\system\ipconf to sys:\system\ipconf, overwriting all existing files.

After completing a NetWare 6.5 to NetWare 6.5 migration using the Migration Wizard, complete 
the following steps to ensure that exteNdTM Application Server installs correctly:

1 Copy sys:\sys.mig\java to sys:\java, overwriting all existing files.

2 Copy sys:\sys.mig\etc\my.cnf to sys:\etc\my.cnf.

Unable to Copy NDS Object Errors

When migrating a NetWare 6.0 server with eDirectoryTM version 8.6.2 to a new NetWare 6.0 server 
with eDirectory 8.6.2, you might encounter an NDS® error stating you couldn’t copy an NDS 
object because you do not have the proper rights. This can occur even if you are logged in as 
Admin. 

Installing eDirectory version 8.7 on the source server and running the migration again resolves this 
issue.

Copying Data from a Compressed to an Uncompressed Volume

When using the Migration Wizard to copy data from a compressed volume to an uncompressed 
volume, or when backing up a compressed volume in uncompressed format, ensure the server has 
enough space left in the volume to accommodate the uncompressed data.

Decompression requires some disk space to decompress the file and back it up. Having a small 
amount of space left on the system might result in a server abend or unwanted behavior in the file 
system.
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Installing Native File Access for UNIX after the Migration

After completing a NetWare 5.1 to NetWare 6.5 migration using the Migration Wizard, complete 
the following steps to ensure that Native File Access for UNIX installs correctly:

1 Delete the NFAUUser object.

2 Run the schinst utility.

Syntax: 

schinst -n -w

SCHINST takes the administrator's FDN and password as input for extending the schema.

3 Run nisinst.

4 Execute nfsstart.
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5 Server Consolidation Utility

For additional issues related to the Novell® Server Consolidation Utility, see the Readme located 
with the Novell Server Consolidation online documentation (http://www.novell.com/
documentation/lg/servercon20).

The Compare Feature Shows Attributes Are Different

When a Read-only file is copied with the Novell ClientTM, the Rename Inhibit (RI) and Delete 
Inhibit (DI) attributes should be automatically set, but the latest version of the Novell Client (4.90) 
does not set the RI or DI attributes. This is an issue with the latest client. 

The Server Consolidation Utility, as expected, does set the RI and DI attributes when copying a 
Read-only file. However, if you choose to have the Server Consolidation Utility perform a file 
compare between the source and destination files after the consolidation completes, the log file 
will show that the source and destination attributes are different. This is because the source file is 
marked Read-only and the RI and DI attributes are not set, but the files on the destination server 
had the RI and DI attributes set by the Server Consolidation utility.

Although the Novell Client does not properly set the RI and DI attributes at this time, the Server 
Consolidation and NetWare Copy utilities do. To access the NetWare® Copy utility, right click the 
red N in the system tray of your workstation, then select NetWare Utilities > NetWare Copy.

Japanese Backslash Copies Directories to Root

The backslash character (\) used in the Japanese version of the Server Consolidation Utility to 
separate directories in a pathname causes directories to be copied to the Root. 

For example, if three folders named Example1, Example2, and Example3 reside in the Test 
directory on the source server (root\test\example1, root\test\example2, and root\test\example3), 
they will be copied to the destination server as root\example1, root\example2, and root\example3. 
The test directory they resided in on the source server is not copied, only its contents are.

Copying Data from a Compressed to an Uncompressed Volume

When using the Server Consolidation Utility to copy data from a compressed volume to an 
uncompressed volume, ensure the server has enough space left in the volume to accommodate the 
uncompressed data.

Decompression requires some disk space to decompress the file and back it up. Having a small 
amount of space left on the system might result in a server abend or unwanted behavior in the file 
system.
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Last Accessed Date Errors in the Log File

When you choose to have the Server Consolidation Utility perform a file compare after the copy 
process completes, it might report "Last Accessed Date" errors in the log file.

For example, if the source file has a Last Accessed Date of June 10, 2003, and that file is copied 
to a destination server on June 15, 2003, the file on the destination server retains the source file's 
Last Accessed Date of June 10, 2003. However, the source file's date is changed, after the copy 
completes, to June 15, 2003. This is caused by Novell SMSTM accessing the source file when it 
backs up the file during the consolidation process. When the Server Consolidation Utility proceeds 
to compare the file attributes, it flags an error because the Last Accessed Date has changed on the 
source. 

The destination file is correct, only the source file's attribute is changed. This issue can also occur 
with the destination file's attribute.

This occurs on all files, traditional and compressed, copied from NetWare 4.x or NetWare 5.0 
source servers. It also occurs on fully patched NetWare 5.1 and NetWare 6.0 source servers, but 
only with compressed files, not traditional files. 

This issue will be resolved in the next Support Pack release for NetWare 5.1 and NetWare 6.0 and 
in Support Pack 1 for NetWare 6.5.
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6 Apache Web Server on NetWare

Remote Upgrades

If during a remote upgrade you accept the defaults for the LDAP server (specifically, Require TLS 
for Simple Binds), the Apache2 Admin Server will not get configured properly.

There are three ways to resolve this issue:

1. Uncheck the Require TLS for Simple Binds check box during installation.

2. Give administrative rights to additional users by adding their User objects to the apchadmn-
Administrators group.

3. Run a local post-install of the Apache2 Admin Server from the server GUI; the configuration 
issues will be fixed automatically.

When Upgrading a Server Running Apache Web Server 1.03

When upgrading a NetWare® server that is running Apache 1.03, NetWare 6.5 disables version 
1.03. As long as Apache 2.0 is selected during the install, the install transitions Novell® software 
that is dependent on Apache to use Apache 2.0.

If you have other programs configured to use Apache 1.03, we recommend that you reconfigure 
them to use Apache 2.
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7 Beans for Novell Services

Beans Included

The following Beans for Novell® Services are included with NetWare® 6.5. Additional Readme 
information is located on the Novell Developer Web site (http://developer.novell.com).

LDAP Beans (http://developer.novell.com/ndk/readme/bns_ldap.html)

LDAP Command Beans (http://developer.novell.com/ndk/readme/bns_ldapcmd.html)

Novell NsureTM UDDI Command Beans (http://developer.novell.com/ndk/readme/
bns_uddicmd.html)

SecretStore Command Beans (http://developer.novell.com/ndk/readme/bns_sscmd.html)

Security Command Beans (http://developer.novell.com/ndk/readme/bns_seccmd.html)

WebDAV Command Beans (http://developer.novell.com/ndk/readme/bns_wdavcmd.html)

Samples for Novell LDAP Command Beans and Security Command Beans

The JSP samples for Novell LDAP Command Beans and Security Command Beans are 
shipped with the respective Beans. These samples can be accessed from the server welcome 
page. The samples have a dependency on Apache and Tomcat and, therefore, can be 
configured automatically only if the Apache or Tomcat pattern is selected during the NetWare 
server install. 

In all other cases, install Apache and Tomcat and do one of the following:

Perform a post install for Beans for Novell Services.

Include the following line at the end of httpd.conf (Apache configuration file):

Include sys:/tomcat/4/conf/beans-apache.conf

Then restart Apache and Tomcat.

To access samples, do one of the following: 

Go to the NetWare server welcome page, then click J2EE / Web Services > Beans for 
Novell Services.

In a browser, go to http://server/ecb/index.html, where server is the DNS name or IP 
address of the NetWare 6.5 server.
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8 ConsoleOne 1.3.6

Using ConsoleOne to Manage NetWare 4 Servers

In order to use ConsoleOne® to manage a tree containing NetWare® 4 servers (NDS® v 6.17), 
IPXTM must be installed on the management client. Even if ConsoleOne is run from a NetWare box 
via a mapped drive on the client, the client machine that ConsoleOne is running on must be able 
to connect natively via IPX.

ConsoleOne Installation during a Remote Upgrade

ConsoleOne 1.3.6 might fail to install on the server during a remote upgrade using nwdeploy.exe. 
If this happens, use any of the post-install methods to install ConsoleOne on the server.

Menu Keyboard Navigation Indicators Are Not Displayed

When running ConsoleOne on some versions of Windows, the accelerator key indicators for menu 
items might not be displayed. This is due to a defect in the Sun* JRE 1.4.1_01 that ConsoleOne 
uses when running on the Windows platform. The workaround to this problem is to configure 
Windows, in the Display Control Panel, to not hide keyboard navigation indicators.

Using the Alt Key to Enter International Characters

Using the Alt+number keys to type international characters when naming objects in ConsoleOne 
causes the characters to display incorrectly. The workaround for this is to use an international 
keyboard or to copy the extended characters from Notepad or another Windows application into 
the ConsoleOne text field. Manually upgrading your JRE to version 1.4.1_02 will also fix this 
problem.

Novell Client Versions Required for ConsoleOne 1.3.6

ConsoleOne errors might be encountered during authentication and password modification 
operations when running on a Windows workstation with an older version of the Novell ClientTM. 
ConsoleOne 1.3.6 on Windows requires one of the following:

Novell Client for Windows 95/98 version 3.4 or later

Novell Client for Windows NT/2000/XP version 4.9 or later
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9 DirXML Starter Pack

Authentication Problems during Installation

If you experience authentication problems during the installation, and if you are certain your 
authentication information is correct, you should ensure that the NCPTM packet signature level is 
not set to 3. If the parameter value is set to 3, you will see a -864 error in DSTrace. You should set 
the value to 1, reboot your computer, run the installation program, then set the value back to 3 to 
maintain the same security level. 

NCP packet signatures determine the level of enhanced security support. Enhanced security 
includes the use of a message digest algorithm and a per-connection/per-request session state. The 
values are as follows: 0=disabled, 1=enabled but not preferred, 2=preferred, and 3=required. 
Setting this parameter to 2 or 3 increases security, but decreases performance.

Installation from a Non-CD Source

When you use NWCONFIG and run the installation program from a non-CD source, you must use 
an 8.3 file naming convention. If the installation directory path contains a long name, the path gets 
truncated and you might encounter any of the following symptoms during installation: failure to 
open source files, failure to extend the schema, or failure to update the ConsoleOne® snap-ins.

To resolve this, you should change the directory path name to an 8.3 file format (for example, from 
sys:install/dxl_starter_pack to sys:install/dirxmlsp)

Exporting Driver Configurations

Exporting a driver’s or driver set’s configuration preserves all of its rules, style sheets, and 
parameter settings in a single XML file that can be imported if driver restoration is necessary or if 
the current configuration represents the best starting point for a future configuration. Depending 
on the amount of configuration information associated with a driver or driver set, this process can 
take several minutes or longer. Also, drivers with large schema definitions might also take several 
minutes to export.

If you click Finish and close the Export Wizard before you have clicked Save As or copied the 
XML text, then all export information, including any prompt strings you entered, is lost.
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Known Issues

While upgrading to NetWare® 6.5, if you have the load named command in the existing 
autoexec.ncf file, with any option that is not supported by NetWare 6.5, the DNS Server will 
not load automatically when the autoexec.ncf is executed after an upgrade.

If you have an unsupported option in the autoexec.ncf file, the usage details will be displayed 
on the logger screen.

In order to avoid this, before upgrading to NetWare 6.5, ensure that the autoexec.ncf file does 
not contain the following options: -m, -u, -l, -r, -f, -a, -b, -pc, -strict [on|off], -s, -v, -q.

For information on DNS Server options, see Command Line Options in the Novell DNS/
DHCP Services Administration Guide for NetWare 6.5.

In the case of a multiple zone-in transfer, the server might be unresponsive to queries. You can 
avoid this by specifying a higher value for the -n command line option. This value need not 
be the same as the number of CPUs available.

In a clustered environment, you might encounter the critical: failed reading 
LocatorPtr attr from Server obj message. This message can be ignored.

The ICE Zone Handler utility does not add the Group object as a trustee to the Zone objects 
that it creates. If the zones are created using ICE Zone Handler in a different partition where 
there is no replica available locally for the DNS Server, the server cannot load the zones. You 
must manually add the Group object (DNSDHCP-GROUP) as a trustee to such Zone objects 
in order for the server to load the zones.

For dynamic updates from Novell® DHCP servers, the targeted forward zone and its 
corresponding reverse zone should be serviced by the same DNS Server in Designated 
Primary mode. This will ensure that the DNS Server is authoritative for both the forward and 
the reverse zones.
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11 eGuide 2.1.1

For Novell® eGuide 2.1.1 issues, see the Readme (http://www.novell.com/documentation/lg/
eguide211/readme/eguide_readme.html) located with the Novell eGuide 2.1.1 online 
documentation (http://www.novell.com/documentation/lg/eguide211/index.html).
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12 exteNd Application Server

For complete information on using the Novell® exteNdTM Application Server, see the online help 
included with the software or the exteNd Application Server 5.0 online documentation (http://
www.novell.com/documentation/lg/extendas50).

Performance Considerations with Console Output

The console screen for the Novell exteNd Application Server displays when you select exteNd 
Application Server from the Current Screens list on the NetWare® system console. Displaying the 
application server's console reduces performance as messages are written to the screen. To 
optimize performance, keep the application server's console closed as much as possible; in other 
words, as soon as you're finished using it to investigate a message or problem, press Ctrl+Esc to 
exit (and return to the Current Screens list).

To improve performance on those occasions when you need to display the application server's 
console, use the Server Management Console (SMC) to turn off any messages you don't require.

If significant output is going to the application server's console, the steps above might not be 
adequate to ensure good performance. You might need to direct that output to the NetWare Logger 
Screen instead of the application server's console. To do this, use the -nomonitor option when you 
start silverserver.

Heap Size and Application Server Performance

If you experience response-time problems, you might need to increase the memory heap size for 
the Novell exteNd Application Server. This can occur in the following situations:

When a large number of the browser clients are connected (this number varies depending on 
your application and hardware configuration)

When the application requires more memory to run

The default heap size is 256 MB (shown as 335544320 for the reserved heap). Slow or no response 
for the application server occurs when the committed heap grows to over 250 MB and is not 
released. If the committed heap continually stays over 250 MB, then a larger heap is required. 

To view the heap size, use the java -showmemory<id> command. To increase the heap size, restart 
the application server with the new size specified on the command line. For example: 

silverserver +Xmx400M

Restarting the Novell exteNd Application Server from the SMC

On NetWare 6.5, when you use the Restart button in the SMC, the application server shuts down 
but doesn't start up again. In this case, you need to restart the application server manually from the 
NetWare console; use the silverserver command and include any startup options that you normally 
run the application server with.
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Setting the Maximum Number of Client Connections in SMC (Connection Tab)

Make sure that the maximum number of client connections is set appropriately for your machine 
and its RAM. Each client results in the creation of a Java thread. By default, each thread is 
allocated a stack size of 262,144 bytes (256k bytes). Each stack is created in physical RAM 
memory. 

For example, if the number of clients is specified at 250, then the amount of physical memory 
required when the exteNd Application Server is active is 65,536,000 bytes (62.5 MB). The formula 
in bytes is 256 × 1024 × number of clients.

You also need to consider the value for dynamically allocated client connections, which the system 
requires to be equal to or greater than the maximum number of client connections. The potential 
number of active threads can be this number. Therefore, the amount of physical memory 
potentially used for the stack space should be based off this number.

The number of active threads is always at least the maximum number of client connections 
specified. The number of active threads can grow to the number of dynamically allocated client 
connections.

Setting the maximum number of client connections higher than needed uses extra physical 
memory. This doesn't happen with the setting for dynamically allocated client connections 
(because threads are not allocated unless used).

When the Java Virtual Machine (JVM*) allocates a new thread and physical memory is not 
available for thread creation, then the JVM aborts the application and returns a -4 (out of memory) 
error. The application server will not run when there is not enough physical memory available to 
allocate threads.

If the number of clients specified is too high and the application server won't start (because of the 
failure to allocate physical memory), the solution is to reinitialize the database. The configuration 
parameters are stored in the database during the initialization process. The SilverInit.ncf command 
file is provided to reinitialize the system.

Limitation on Upgrades from NetWare 5.1

Upgrading from NetWare 5.1 won't succeed because of problems installing MySQL* (which is 
required by the application server). In this scenario, MySQL is installed on the traditional file 
system volume sys:, but it works only on an NSS volume. As a result, both MySQL and the 
application server fail. For more information, see the issue titled When Upgrading from NetWare 
5.1 and Installing MySQL and the Novell exteNd Application Server in Chapter 17, “MySQL for 
NetWare,” on page 49.

Preparing to Use a Remote MySQL Database as SilverMaster

The application server installation on NetWare asks you to specify a database to be used as 
SilverMaster (which will contain the application server's system information). You can specify a 
remote MySQL database, if appropriate, but you must first make sure that database is properly 
configured.

The application server installation automatically takes care of that configuration when the target 
MySQL database is on the local machine or on a remote machine in the same application server 
cluster. For any other remote MySQL database, you must perform the following configuration 
steps manually.
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1 On the remote MySQL server, edit sys:/etc/my.cnf (the path is different on Windows and 
Linux).

1a Add the following lines:

innodb_data_file_path=ibdata1:10M:autoextend

innodb_mirrored_log_groups=1

innodb_log_files_in_group=2

innodb_log_file_size=5M

innodb_log_buffer_size=1M

innodb_flush_log_at_trx_commit=0

innodb_log_archive=0

innodb_buffer_pool_size=8M

innodb_additional_mem_pool_size=1M

innodb_file_io_threads=4

innodb_lock_wait_timeout=50

1b Make key_buffer at least 16 MB.

1c Make max_allowed_packet at least 5 MB.

1d Comment out skip-innodb (change it to #skip-innodb).

2 Restart MySQL.

3 Execute the following commands on the remote MySQL server (replacing password with a 
password of your choice): 

3a create database SilverMaster50

3b use SilverMaster50

3c grant all on SilverMaster50.* to appserver@'%' identified by 
'password'

3d grant all on SilverMaster50.* to appserver@localhost 
identified by 'password'

3e create database jBrokerMQ

3f use jBrokerMQ

3g grant all on jBrokerMQ.* to appserver@'%' identified by 
'password'

3h grant all on jBrokerMQ.* to appserver@localhost identified 
by 'password'

4 Proceed with the installation of the application server on NetWare. 

When prompted, specify the remote MySQL hostname and make sure Execute 
SilverMasterInit is checked.
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Downloading SilverJ2EEClient from the Application Server

SilverJ2EEClient is the J2EE* application client container for the Novell exteNd Application 
Server. To install SilverJ2EEClient on a client machine, you can download the appropriate 
SilverJ2EEClient installer from the application server. If your application server is running on 
NetWare, you should sidestep Apache (default port 80) for this download and specify port 83 in 
the download URL to access the application server directly. This ensures an efficient download 
(by avoiding a memory usage issue that currently exists in the application server's Apache WSI 
module).

Here are the resulting download URLs to use for the SilverJ2EEClient installer (depending on your 
target client machine):

Windows client: 

http://servername:83/SilverStream/SilverJ2EEClientInstall/SilverJ2EEClientInstall.exe
NOTE: In some cases, Internet Explorer might strip the .exe extension from this filename when saving it. 
If so, you will need to add .exe to the filename yourself.

Solaris* client: 

http://servername:83/SilverStream/SilverJ2EEClientInstall/
SilverJ2EEClientInstallSolaris.sh

Linux* client: 

http://servername:83/SilverStream/SilverJ2EEClientInstall/SilverJ2EEClientInstallLinux.sh

Updating jBroker MQ Configuration after SilverMasterInit

If you execute SilverMasterInit and specify a new password (different from the one you used when 
installing the application server), that new password is not automatically added to the jBroker MQ 
configuration file. Edit the following file and set msgsvc.jdbc.password to your new password:

sys:\extend\appserver\jbrokerMQ\lib\msgsvc.properties

Port Conflict for jBroker MQ Configuration

The port number in the jBroker MQ configuration file is not managed by the IP Address 
Management framework. If there's a conflict with port 3506, edit the following file and set the port 
number manually:

sys:\extend\appserver\jbrokerMQ\lib\msgsvc.properties
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13 exteNd Workbench

For complete information on using Novell® exteNdTM WorkbenchTM, see the online help available 
with the software or the exteNd Workbench 4.1.1 online documentation (http://www.novell.com/
documentation/lg/workbench41/index.html).
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14 iManager 2.0

For Novell® iManager 2.0 issues, see the Readme (http://www.novell.com/documentation/lg/
imanager20/readme/imanager_readme.html) included with the Novell iManager 2.0 online 
documentation (http://www.novell.com/documentation/lg/imanager20/index.html).
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15 IP Address Management 

Uninitializing Httpstk.nlm

When httpstk.nlm is unloaded at the server console, ipmcfg.nlm is not uninitialized.

Debugging Messages

Some debugging messages might appear on the system console/logger screen when an application 
configuration change is made. 
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16 iSCSI for NetWare

Known Issues

AUTH_NONE is the only authorization method supported. This means that there is no 
authentication mechanism available between initiators and targets.

After executing the LIST DEVICES command at the server console, there might be a delay 
before the device list is displayed.

Occasional slow performance or dropped iSCSI connection problems might occur with 
certain router, switch, and hub configurations.

These network configurations might require that SACK (Selective ACK) be turned off for the 
TCP/IP stack running on the initiator. You can do this at the NetWare® server console by 
entering

set tcp sack option=off
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MySQL Options Screen Does Not Display during Installation

If you cancel the installation of MySQL after its files have already been copied to the server and 
then attempt to install MySQL again, the MySQL Options screen that normally appears during 
installation will not be displayed. This is because when the files were copied during the first 
installation attempt, the default volume:\etc\my.cnf configuration file was also copied. When the 
install finds this file on the second attempt, it assumes MySQL was previously installed and so it 
does not display the MySQL Options screen. 

To resolve this issue, delete the my.cnf file before you attempt to install MySQL again.

When Upgrading from NetWare 5.1 and Installing MySQL and the Novell exteNd 
Application Server

When upgrading from NetWare® 5.1 and installing MySQL, a message will appear indicating that 
MySQL cannot run on a traditional volume. Because NSS volumes are not mounted or created 
during an upgrade, perform the following steps to configure MySQL and the Novell® exteNdTM 
Application Server to run correctly:

1 After first upgrading your NetWare 5.1 server to a NetWare 6.5 server, create an NSS volume 
or upgrade existing NSS volumes. 

To create a new NSS volume, use the NSS Management Utility. Enter nssmu at the 
system console.

To upgrade an existing NSS volume, enter NSS /Zlssvolumeupgrade=all at the 
system console.

2 Edit sys:\etc\my.cnf by entering the correct volume and path to the MySQL data directory. 

For example:

datadir=nssvol:/mysql/data

3 At the NetWare console, enter 

mysql_install_db

mysqld_safe

perl SYS:\mysql\scripts\mysql_secure_installation.pl

The last command runs the mysql_secure_installation.pl Perl script, which lets you configure 
security for MySQL.
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4 (Conditional) If the Novell exteNd Application Server was installed, it must also be 
configured after the MySQL configuration steps have been completed. 

At the system console, enter

load silverinit appserverpassword adminpassword 
mysqlrootpassword

NOTE: Each of these passwords is explained in the sys:\exteNd\AppServer\bin\silverinit.ncf file.

Username and Password When Using phpMyAdmin

When you access phpMyAdmin from the Web Manager home page (on port 2200), you are 
prompted for a username and password. The username and password being requested are your 
MySQL username and password. By default, the username is root and there is no password.

Using MySQL 4.0.13 with NetWare 6.5

Because NetWare 6.5 has a newer LibC, do not use MySQL 4.0.13 with it.

MySQL Test Suite Can Run Only on NSS Volumes

The MySQL test suite (mysql_test_run.nlm) creates its own databases relative to where 
mysql_test_run.nlm resides. For example, the default sys:\mysql\mysql-test\mysql_test_run.nlm 
creates databases under sys:\mysql\mysql-test\var. On NetWare, MySQL databases must reside on 
NSS volumes. Therefore, mysql_test_run.nlm can be run only from an NSS volume.

Unload MySQL before Rebuilding NSS Volumes

If you need to rebuild an NSS volume where MySQL is installed and running, unload MySQL 
before doing so.

For more information about NSS pools and volumes, see Managing NSS Pools and Volumes in the 
Novell Storage Services Administration Guide for NetWare 6.5.

Legal Issues

For important legal issues related to your use of MySQL 4.0, refer to the sys:\mysql\license.doc 
file after installation.

Accessing the Official MySQL Documentation

To access the official MySQL documentation, visit http://www.mysql.com/doc (http://
www.mysql.com/doc). 
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18 NetWare FTP Server

Data Transfer Issues

NetWare® FTP Server does not support FTP operations for files larger than 4 GB.

FTP operations such as directory listing and size commands for files larger than 2 GB display 
size in negative values such as -1. You can ignore these file sizes.

Using FTP Server iManager Snap-ins

While administering FTP Server through iManager on a server, administering another sever 
or other tree is not supported.

The FTP Server iManager snap-in does not work in the NetWare Remote Manager browser.

Localization Issues

When using FTP Server on a Japanese language machine, users might not be placed in their 
home directories. 

To resolve this, replace backslashes (\) with forward slashes (/) as path separators in the user’s 
home directory path. In ConsoleOne®, right-click User and then click Properties > General > 
Environment > Modify.

If you create a file or directory in a DOS name space on a server with double-byte characters, 
the file or directory is created on that server with the name specified. However, the message 
to the FTP client might contain a different file or directory name. This happens in particular 
with the 0x8374 character in Shift_JIS, 30D5 in Unicode*, which is converted to 0x8354 in 
Shift_JIS, 30B5.
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19 NetWare Web Search Server

Web Search Synchronization Can Cause Not_Logged_In Connections to Keep Growing

By default, Web Search requires administrator authentication when processing Synchronization 
requests. However, the initial release of NetWare® 6.5 does not release the Not_Logged_In 
connections that appear in the Connections link in NetWare Remote Manager (NRM).

To resolve this issue, open NRM and click Clear All Not Logged In Connections to clear them. 
Alternatively, set the Require Admin Authorization When Receiving Cluster Data option in the 
Global Synchronization Settings page of Web Search Manager to No.

Duplicate Indexes

When using Web Search’s new Synchronization feature, a duplicate index could be created in the 
indexes list. In turn, this causes duplicate hits to appear on the search results page.

To resolve this issue, delete one of the duplicate index entries using Web Search Manager.

Using Double-Byte Characters with Usernames and Passwords

Web Search does not yet support double-byte characters for usernames and passwords when 
logging in. This applies to both client and administrator logins.

Authentication Methods for Rights-Based Searches

In prior releases of Web Search, the basic authentication method was used for getting users’ 
credentials when performing rights-based searches. This method depended on a user’s own Web 
browser login dialog box. 

Web Search for NetWare 6.5 continues to support this legacy authentication method for logging 
in. However, when using this method, the logout feature does not work.

Web Search's new mechanism for getting user credentials is form-based. This means that 
administrators have complete control over the appearance and behavior of the login fields. We 
strongly recommend modifying any existing templates that still depend on the legacy 
authentication method to use the new form-based login method. For an example of how to do this, 
see the SignIn.html template. 

An alternative solution is to use a shorter auto-logout time in the security settings of Web Search 
Manager.
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20 Novell Certificate Server

Browser Support

You must use Internet Explorer 5 or later or Netscape* Navigator* 4 or later to use the certificates 
generated by Novell® Certificate ServerTM for SSL or LDAP connections. Older browsers are not 
supported.

Removing a Server from eDirectory

When removing a server from Novell eDirectoryTM and then reinstalling it into the same context 
with the same name, a successful reinstallation occurs only if the SAS Service object representing 
the removed server is also deleted, if it existed.

For example, for a server named MYSERVER, a SAS object named SAS Service – MYSERVER 
could exist in the same container as the server. This SAS object must be manually deleted (using 
ConsoleOne®) after the server is removed from the tree, but before the server is reinstalled into the 
tree.
IMPORTANT: If the server is the Organizational CA or the SD Key server, you must complete some additional 
steps. These steps are documented in TID 10056795 (entitled Certificate Server Issues: Removing a Server 
from a Tree). You can search for this TID in the Novell Knowledgebase (http://support.novell.com).

The default server certificates created for the server should also be removed so that they will get 
re-created when the server is reinserted.These certificates are SSL Certificate IP - MYSERVER 
and SSL Certificate DNS - MYSERVER.
WARNING: If data has been encrypted using either of these certificates, the data must be retrieved before 
the certificates are deleted or you will not have the keys to decrypt the data.

Extractable Key Support

When creating the Organizational CA object or Server Certificate objects (also known as KMOs), 
extractable keys are supported only if the server you selected for the key pair generation is running 
eDirectory 8.6 or later on NetWare and Windows NT platforms, or if it is running eDirectory 8.7 
or later on UNIX platforms. If you are attempting to make the keys extractable on an unsupported 
platform, you will receive a -1222 error.

Importing CRL Data onto CRL Object

The CRL file is not inserted into eDirectory when creating a CRL object. After creating the CRL 
object, modify the object and select Import. Again select the file and it will be properly imported.

Certificates for Multiple Users (iManager)

To create certificates for multiple users, use the Create User Certificate task under the Certificate 
Server role. This will allow the administrator to select a list of users and create a certificate for 
each selected user.
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Long DNS Names and Long Server Names

Novell Certificate Server automatically creates server certificates for all the IP and DNS addresses 
configured on the box. You might receive the following error during the installation of Novell 
Certificate Server if the combination of the server name and the DNS name is 54 characters or 
greater due to the maximum object name length of 64 characters: 

The PKI install was unable to create the default IP and DNS certificates. Error -613. Do you want 
to retry?

The -613 error is not a fatal error; however, Novell Certificate Server will not be able to create the 
auto-generated certificates which match the long DNS name.

To avoid this problem with future servers, make sure that the combined number of characters of 
the DNS name and the server name is fewer than 54 characters.

To fix this problem on an existing server, use ConsoleOne or iManager to manually create a server 
certificate using the DNS name or the IP address as the certificate subject name, depending on the 
needs of your applications.

See the Novell Certificate Server Administration Guide (http://www.novell.com/documentation/
lg/crt252/index.html) for instructions on how to create server certificates.

After the server certificate is created, the applications (Apache, Tomcat, etc.) on which you want 
to use the new server certificate will need to be configured to do so.
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21 Novell Client for Windows

For issues related to the Novell® ClientTM for Windows 95/98 and Novell Client for Windows NT/
2000/XP, see the Readme (http://www.novell.com/documentation/lg/noclienu/index.html) located 
with the Novell Client online documentation.
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22 Novell Cluster Services

For detailed information on configuring different products and components with Novell® Cluster 
ServicesTM, see the Novell Cluster Services 1.7 Resource Configuration Guide.

Directory Tree Not Visible during Installation

When running the Cluster Services installation, you occasionally might be unable to see the Novell 
eDirectoryTM tree you want to install into from the installation browser. If this happens, type the 
name of the tree in the browser address (URL) field: treename/cluster.context.

Cluster Node Fails to Auto-Start after Installation

If Cluster Services (clstrlib.nlm) does not automatically start on a node immediately after 
installation, start it manually by entering the ldncs command at the server console.

Upgrade Does Not Upgrade Licenses

If you are performing a rolling cluster upgrade from NetWare® 6.0 to NetWare 6.5, you must 
manually apply new licenses for any additional nodes in your cluster beyond the first two nodes.

NCP Connection Required prior to Installing Novell Cluster Services

Prior to running nwdeploy.exe, you must have a client connection established from the workstation 
running the Novell Deployment Manager to each server where Novell Cluster Services will be 
installed or upgraded.

The easiest way to do this is to use Windows Explorer to browse the eDirectory tree to the sys: 
volume of each server in your cluster to be upgraded or installed. Opening the sys: volume folder 
on a server automatically creates a connection to that server.

ConsoleOne Required to Create Home Directories on Virtual Servers

Home directories currently cannot be created on cluster-enabled volumes using iManager. You 
must use ConsoleOne® to create home directories on cluster-enabled volumes (virtual servers).

Disregard Warning Message after Installing Licenses during Cluster Upgrade

During a server upgrade, a warning message appears indicating that Cluster Services licenses must 
be installed before upgrading the server. This message is valid if no licenses are installed, but it 
continues to appear even after installing cluster node licenses. Disregard the message after 
installing the appropriate licenses.
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23 Novell eDirectory 8.7.1 for NetWare

For Novell® eDirectoryTM 8.7.1 for NetWare® information, refer to the Readme (http://
www.novell.com/documentation/lg/edir871/readme/nwreadme.txt) located with the eDirectory 
8.7.1 online documentation (http://www.novell.com/documentation/lg/edir871/index.html).
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24 Novell iFolder 2.1

For Novell® iFolder® 2.1 issues, see the Readme located with the Novell iFolder online 
documentation (http://www.novell.com/documentation/lg/ifolder21/index.html).
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25 Novell International Cryptographic 
Infrastructure (NICI)

The version of NICI shipping with this release contains components, such as xengexp or xengusc, 
that might abend under low memory conditions when running on Intel* P4 or later processors. 
There is no workaround at this time. To avoid this problem, ensure that the NetWare server does 
not run out of memory.
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26 Novell IPv6

Apache2 for IPv6

To use Apache2 for IPv6, copy the winsock NLMTM files from sys:\research\ipv6\winsock to 
c:\nwserver. Also copy the folders and NLM files from sys:\research\ipv6\apache2 to 
sys:\apache2.   

Deleting Boards

If there are multiple boards of the same type, removing one board might result in unbinding IPv6 
addresses from all of the boards. This is because the driver unloads and reloads when a board is 
deleted.

Range Checking

Range checking for the variables in ip6.cfg and rtadvd.cfg is not yet implemented.

Memory Leakage

On every unload and reload of the IPv6 stack, 728 resources of 4 KB will not be freed and will 
remain in memory unless the machine is rebooted. 
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27 Novell JVM for NetWare

Changes to the Taskbar Menu

Changes you make to the Novell® JVM for NetWare® GUI do not immediately appear on the 
taskbar menu. You must close and restart the GUI in order for the changes to take effect.To close 
the JVM GUI, click Novell > Close GUI. To restart the GUI, use the startx console command.
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28 Novell Licensing Services

Installing Server Licenses

The server license certificate can be installed in multiple containers of a Novell® eDirectoryTM tree, 
but the license certificate can be installed only once in the same container. 

The server license will support up to 1,000 servers installed in the same container or below.
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29 Novell Modular Authentication Service (NMAS)

Installation Issues

You must have the NICI Client installed on each client workstation that will run ConsoleOne® 
and NMASTM software.

For information on installing and configuring NMAS on UNIX platforms, see Using nmasinst 
Utility to Configure NMAS in the Novell eDirectory 8.7.1 Quick Start (http://
www.novell.com/documentation/lg/edir871/qsedir871/data/a79kg0w.html).

Methods and Sequences Issues

If a login method's snap-ins are already present and you try to install the same login method 
again, you will receive a failed status displayed in the login methods installation summary 
dialog box. This occurs only when running ConsoleOne from the server.

Nmasinst does not have an option to remove NMAS methods. This must be done using 
ConsoleOne. See the NMAS Administration Guide (http://www.novell.com/documentation/
lg/nmas22) for more information.

In order for products to use NMAS login methods properly, at least one NetWare® 6.5 server 
in the eDirectoryTM partition must hold a Read/Write replica of the User objects that will be 
using NMAS.

Snap-ins for managing the Enhanced Password login method can be installed into 
ConsoleOne by executing \nmas\consoleone\snapininstall.exe.

If you do not restart the server after installing NMAS and you try to reset passwords, you will 
receive an error message.

Two password methods, such as Simple and Enhanced, cannot be used in an AND sequence 
if the Novell® ClientTM is set to display the password field, which it is by default.

If you use a login sequence that has a non-password method (for example, the X509 method) 
followed by a password method (for example, the simple password method), the user must 
type the credential for the password method in the initial Novell Client Login Dialog 
Password field before providing the non-password credential. After typing the credential for 
the password method, the user will then be prompted to type the password to unwrap the 
certificate, thus providing the credential for the non-password method.

Administration Issues

Updating ConsoleOne from 1.2d to 1.3.6 does not update the products.dat file on the NetWare 
server.

NMAS does not support AIX 4.3.3.

The simple password is used for various authentication services in NetWare 6.5. This includes 
the authentication support for CIFS and AFP.
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A problem might arise if you set or change a user’s simple password from the ConsoleOne 
administrative snap-ins using Force Password Change. If you experience problems setting an 
initial password, you might need to check the Force Password Change check box. If the user 
already has a password set, Force Password Change might not work unless you remove the 
current password and specify a new one.

You must give explicit rights to users with graded authentication. Inherited rights do not work. 
For example, an administrator's Supervisor right is defined at the [Root] container. Rights for 
the administrator are not defined in the Volume object. So if the administrator changes the 
volume's security label from Logged In to any other security label, the administrator cannot 
get the appropriate rights. The administrator must assign explicit rights to the volume, 
directories, or files in the volume.

When a user logs in to a tree other than the preferred tree using the client, the client incorrectly 
queries the preferred tree to find the User object. If a user object with the same name exists in 
the preferred tree, the client will use that User object, which results in the login failing with a 
-601 error (No Such Object). This is because the wrong tree was used. This issue will be 
resolved in the next release of the client.

Universal Password Issues

When you disable a user's NDS® password, the NDS password is set to an arbitrary value that 
is unknown to the user. When Universal Password is enabled, the Universal Password 
attribute is set with this same arbitrary value, causing the simple password and the enhanced 
password methods to become disabled. Disabling an NDS password on a fully enabled 
Universal Password system will also disable other employed methods, including the simple 
password and enhanced password methods.

iManager provides a Universal Password task that allows you to enable and disable Universal 
Password. This page also displays the option for NMAS to automatically synchronize the 
Universal Password with the simple password, whenever a user performs a password update. 
If you are concerned about the security properties of simple password, you can choose not to 
synchronize the Universal Password with the simple password by unchecking this option. But 
if you have NetWare 6.0 servers in the tree that contain AFP/CIFS users, you should check 
the option to synchronize the Universal Password with the simple password.

If you add an eDirectoryTM 8.7.1 server to an existing tree or upgrade eDirectory 8.7 that has 
NMAS and the simple password method installed in eDirectory 8.7.1, users authenticating 
through LDAP might find that the Universal Password did not synchronize with the simple 
password. Configuring the NMAS and simple password method again on eDirectory 8.7.1 
will resolve the issue.

In this release, the NDS password is not migrated to the Universal Password when doing an 
LDAP bind.

In the case when Universal Password is enabled and you are using Novell Client for Windows 
version 4.9, passwords are case sensitive. The first time a user logs in with this version of the 
Novell Client, the password is validated and then set using the case-sensitive password as 
provided by the user. If the user logs in first with CIFS or AFP, the CIFS/AFP password (the 
simple password) will be used to set the new password.

The NetWare 6.5 installation does not perform password migration for the user who is 
performing the installation or upgrade.
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30 Novell NetDrive 4.1

WebDAV Support

Novell® NetDrive 4.1 supports secure HTTP (HTTPS) for WebDAV only on Windows NT 4/2000 
and Windows XP workstations.

Using the NetDrive Client behind a Firewall Regulated by BorderManager

If your Novell NetDrive client is behind a firewall regulated by a BorderManager® server that is 
configured for FTP proxy and authentication, NetDrive cannot map a network drive via FTP to 
any servers that reside outside the firewall. To solve this problem, disable the FTP proxy 
authentication on the BorderManager server.
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31 Novell Native File Access Protocols 

The Novell® Native File Access Protocols issues are divided into the following sections:

“General Issues” on page 77

“Macintosh/AFP Issues” on page 77

“Windows/CIFS Issues” on page 79

“UNIX/NFS Issues” on page 80

General Issues
CIFS, AFP, and NFS Protocols Installed by Default

The CIFS, AFP, and NFS protocols are installed by default when you install NetWare® 6.5.

Disabling the Software

To disable CIFS and AFP, see Enabling and Disabling CIFS and AFP in the NetWare 6.5 Native 
File Access Protocols Guide.

To disable NFS, complete the following steps on each server running NFS:

1 Run nfsstop at the server console.

2 Remove the NFSSTART line from the autoexec.ncf file.

Nmas.dll Could Not Initialize Cryptographic Services (-1461)

If any of the following errors appear s when launching ConsoleOne®, you need to install NICI 
Client 2.6 or later on the administrator workstation:

NMAS.DLL could not initialize cryptographic services or cryptographic 
services are not available. (-1461)

NMAS.DLL is unloading b/c of errors during initialization. 

The library NMASWrap could not be located.

Macintosh/AFP Issues
Three Grace Logins Required on Universal Password Expiration

If you set a password expiration date using Universal Password, you should notify Macintosh users 
that three grace logins are required to change a password. If users wait until the final grace login, 
they will be denied access to the network and the password will expire.

When Macintosh users are notified that they need to change their password, they will need three 
grace logins in order to log in and change the password. Two grace logins are required for the 
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Macintosh interface (the user logs in once, then logs out, then logs in again to change the 
password). In addition, there is currently a counting problem. When there is one grace login left, 
the user is not able to log in. This issue will be resolved in NetWare 6.5 Support Pack 1.

AppleTalk Not Supported As a Transport Protocol

Older Macintosh applications that have unique dependencies upon AppleTalk* as a transport 
protocol must be updated to a version that is known to work over TCP/IP. The AppleTalk stack 
protocols (TLAP, ELAP, LLAP, DDP, RTMP, AEP, ATP, NBP, ADSP, ZIP, ASP, and PAP) are not 
supported over TCP/IP by Apple*. 

Therefore, we do not support those legacy protocols. Both Novell and Apple have embraced TCP/
IP as the Internet standard transport protocol.
IMPORTANT: Older NetWare for Macintosh and Prosoft versions of afp.nlm and appletlk.nlm are not 
supported. Do not attempt to mix old Macintosh NLMTM programs with the new afptcp.nlm.

Mac OS 8.x Will Not Mount Volumes Checked to Mount at Startup

Mac OS 8.x will not mount volumes checked to mount at startup. To resolve this, add the server 
volume’s alias to the StartUp Items folder inside the System Folder on the Macintosh’s local 
startup disk.

Unloading Afptcp.nlm and Wspdsi.nlm Programs

The Winsock component used by the Macintosh Native File Access NLM does not always clean 
up all open sockets. If you unload afptcp.nlm and then explicitly unload wspdsi.nlm, you might 
get the following warning in flashing red text:

WARNING!!!

1 active Winsock 2 DSI socket session(s)

Unloading WSPDSI.NLM with active session(s) will abend the server.

Unload all Winsock 2 apps with active SSL socket session(s).

Unload module anyway?

The warning is correct. WSPDSI assumes there are still active AFP sessions and it will abend the 
server if you unload it.

There is no need to unload WSPDSI manually. Afptcp.nlm loads it automatically on startup and 
afpstop.ncf does not unload it. It remains loaded. Under normal use, you should not see this 
warning.

Traditional Volume Access Not Supported

Native File Access for Macintosh is supported only on NSS volumes. Traditional volumes are not 
available to Macintosh users.

Do Not Use File or Folder Names Longer Than 98 Characters

Any folder that contains a file or folder name that is longer than 98 characters will cause the 
enumeration of that folder to fail, and the contents of that folder will not be displayed.
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Windows/CIFS Issues
Workstations Might Not Be Able to Access a Windows 2000 Primary Domain Controller

If the Primary Domain Controller (PDC) is a Windows 2000 server, Windows workstations might 
not be able to access the CIFS server. 

To fix this using iManager:

1 In a Web browser, type the following in the address (URL) field:

http://server’s_IP_address/nps/iManager.html

For example:

http://123.45.115.150/nps/iManager.html

2 At the login prompt, enter the server administrator username and password.

3 In the left frame, click File Protocols > CIFS/AFP.

4 Type the NetWare server name where CIFS is running, or browse and select one.

5 Click Properties > CIFS Authentication.

6 Ensure that the Mode is set to Domain and that the Group Name is set correctly.

7 Specify the name and IP address for the Primary Domain Controller, then click Apply.

8 Enter CIFSSTOP and then CIFSSTRT at the server console.

PDC and CIFS on Different Subnets

If the PDC and CIFS servers are on different subnets, you must specify an IP address for the PDC 
on the CIFS Config property page for the Server object.

Password Changes

Trying to change a password from a Windows 9.x or NT4 client workstation might fail if the 
default network username and password in the client’s cache are not a valid combination on the 
CIFS server where the password change was attempted. 

To avoid this problem, validate the username and password combination in the client’s cache on 
the CIFS server before attempting the password change. You can validate by attempting to access 
the file system on the CIFS server by browsing to Network Neighborhood. 

Configuration File Option Not Supported

In previous releases, the configuration setting for Unicode was displayed and changeable in 
ConsoleOne. In NetWare 6.5, this option is still displayed in ConsoleOne, but it is enabled by 
default and cannot be disabled. Checking or unchecking the check box has no effect.

CIFS Server Not Visible in Network Neighborhood

You might occasionally find that your CIFS server is not visible using Network Neighborhood. 
This can happen if you have a domain that contains only Windows 95/98 and no NT/2000/XP 
servers or clients. To correct this problem, enter the server name or IP address in Find Computer.

Traditional Volume Access Not Supported

Native File Access for Windows is supported only on NSS volumes. Traditional volumes are not 
available to Windows users.
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Virtual Server Restart Required after Stopping and Restarting CIFS

If you have CIFS configured to run in ACTIVE/ACTIVE mode and you stop and then restart CIFS 
on a server, you must bring the virtual server resource offline and then online again to cause the 
CIFS ADD command to be executed from the load script. This is required for the cluster to be 
aware that CIFS has been restarted.

CIFS Login Fails in Domain Mode with Windows 2003 Server

Windows 2003 Server performs SMB signing by default. Because CIFS does not do SMB signing, 
pass through authentication requests from a NetWare CIFS server to a Windows 2003 server fails.

To correct this problem, SMB signing must be disabled in the Windows Domain Controller Local 
Security Policy. This policy is applied in LSDOU order (Local, Site, Domain, then OU containers 
in hierarchical descending order). Because of this, more than one policy might need to be modified 
depending on which policies have the policy items enabled, disabled, or undefined (with attention 
to policy blocking and block override).

The following policies require modification on a default Windows 2003 installation:

Local Security Policy (domain controller)

Default Domain Policy

Default Domain Controllers Policy

To modify a policy on a Windows 2003 Server:

1 Click Start > Programs > Administration Tools.

2 Click desired policy > Local Policies > Security Options.

3 Change the policy to the following values:

Microsoft network server: Digitally Sign Communications (always) = Disabled

Network security: LAN Manager Authentication Level = Send LM & NTLM (use NTLMc2 
session security if negotiated)

Trustee Rights Required to CIFS Virtual Server

If the CIFS virtual server (cluster-enabled volume) goes into a comatose state when starting, it 
could indicate that the CIFS ADD command fails to execute in the virtual server load script. This 
problem is common if servers running CIFS do not have trustee rights to the CIFS virtual server.

Ensure servers running CIFS have trustee rights to the CIFS Virtual Server object.

UNIX/NFS Issues
Installing Native File Access for UNIX after the Migration

After completing a NetWare 5.1 to NetWare 6.5 migration using the Migration Wizard, complete 
the following steps to ensure that Native File Access for UNIX installs correctly:

1 Delete the NFAUUser object.

2 Run the schinst utility. 

Syntax:

schinst -n -w

SCHINST takes the administrator's FDN and password as input for extending the schema.
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3 Run nisinst.

4 Execute nfsstart.

NFS Server

Exporting traditional volumes is not supported.

If the NetWare server code page is 932, then the file creation from Japanese EUC NFS clients 
fails for certain characters.

At times, the rm -rf command fails over NFS version 3 over TCP while executing recursive 
deletion.

Exported paths cannot contain spaces. However, filenames and directories containing spaces 
can be created and used under the exported path.

Using iManager for Administering NFS Server

Administering NFS Server through iManager is supported only on the server where iManager 
is installed. You cannot administer NFS using iManager if iManager installed on a different 
server in the same or different tree.

The NFS Server iManager snap-in does not work in the NetWare Remote Manager browser.

A disabled path can be edited from the Netscape browser.

On the Export options screen, the Browse button for Path does not open the File Selector 
window in some browsers, such as Netscape. In these cases, manually enter the pathname.

Error 9600

NDSILIB might not autoload in certain instances. If this happens, it will return Error 9600. To fix 
this problem, run NFSSTOP at the server console and then execute the operation again.

If the issue is not resolved, log in to ConsoleOne or NWADMIN and do the following:

1 Make a note of all the nodes that share the NFAUUser object in that context.

2 Delete the NFAUUser object.

3 Run schinst -n -w on all the nodes that you made note of in Step 1.

Makenis Issues

Do not use makenis to delete users and groups. Use ConsoleOne instead.

Pkernel Messages

If the pkernel screen displays messages similar to the following after executing yppush, ignore 
them. They do not affect functionality.

Out of memory, cannot create UDP Client handle.

Removing Users or Groups from the NetWare NIS Slave Server

When the NetWare server is made a slave NIS Server and users and groups are deleted from the 
master NIS Server, do the following to remove the users and groups from the slave server:

1 From the ConsoleOne main menu, right-click the User or Group object.

2 Click Properties > Other.
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3 Under Attributes, select nisUserGroupDomain and then select the specific domain.

4 Click Delete.
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32 Novell NetStorage

NetWare 6.5 56-Bit International Versions Must Use iFolder 1.03

Novell® iFolder® 2.1 does not support 56-bit encryption. If you are using 56-bit encryption in an 
international version of NetWare® 6.5, you must use iFolder 1.03 to enable users to access their 
iFolder files using NetStorage.

Logging In As a Different User

If you are using Windows 98 and Internet Explorer and, after logging in to NetStorage you intend 
to log in again as a different user, you must first delete Internet Explorer cookies and log out from 
Windows 98 or you will not be able to log in again. This is necessary because Windows 98 retains 
user information and NetStorage cookies are created that are user specific. 

When using Windows 2000 and Microsoft* Web Folders, you must enable the Launch Folder 
Windows in a Separate Process option:

1 Double-click My Computer, then click Tools > Folder Options > View. 

2 Check the Launch Folder Windows in a Separate Process check box.

For all versions of Windows and Internet Explorer, configure Internet Explorer to prompt for 
username and password:

1 Click Tools > Internet Options > Security > Custom Level. 

2 In the User Authentication Setting section, click Prompt for Username and Password > OK > 
OK.

Internet Explorer Unable to Open Some Web Folders

If you use Microsoft Web Folders with NetStorage to create a new folder, you might not be able 
to open that folder using Internet Explorer.

Character Set Issues with Netscape

If you use the Netscape browser to open NetStorage, square boxes will be displayed in place of 
some characters. To resolve this, click View > Character Set > Unicode (UTF-8) and then click 
View > Character Set > Set Default Character Set. 
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33 Novell Nsure UDDI Server

Installation

1 On the component selection page, select Novell® NsureTM UDDI Server and then disable the 
TLS Required for Bind option for the LDAP server. 

 The UDDI server files are located at sys:\uddi.

2 After the installation is complete, verify the UDDI configuration as described in 
“Configuration Verification” on page 85. 

If the configuration fails, execute the following command at the system console to begin the 
installation:

java -cp sys:\etc\UDDIInstall.jar install

This executes the Installation wizard. 

For more information, see Installing UDDI on NetWare in the Novell Nsure UDDI Server 2.0 
Administration Guide.

Post-Installation

Optional Configuration 

To allow publishing in an SSL setup, set EnforceSSLForPublish=Yes in the 
configdir\conf\uddi.conf file, where configdir is the directory selected during installation.

To allow inquiries in an SSL setup, use the Allow Authenticated Inquiry over a Non-SSL 
Channel option (change it to False) and configure your Publish and Inquiry URLs 
accordingly.

For more information on configuring this option, see Using the UDDI Administration 
Interface in the Novell Nsure UDDI Server 2.0 Administration Guide.

Configuration Verification

Test the UDDI server configuration by entering the following in a Web browser:

http://hostname:portnumber/novelluddi/servlet/rpcrouter

where hostname is the hostname or IP address of the server and portnumber is its port number. On 
NetWare, the portnumber is 80 by default.

The following message is displayed on your browser window if the UDDI service is running:

UDDI Server Status

Server Initialized Successfully.

This completes the UDDI server setup. Next, you should create the UDDI roles and tasks in 
iManager in order to start working with the UDDI administration and user access interface tasks.
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Known Issues

Do not use the browser’s Back and Forward buttons for navigating through the UDDI 
administration and user access interface. Instead, use the navigation provided within the 
application.

Do not use the Open in New Window option in Internet Explorer and the Open Link in New 
Window option in Netscape Navigator. 

If the same user authenticates to the UDDI server from multiple workstations, performing a 
discard_authtoken (logout) on any one of these workstations will log out all the current 
connections established by that user; the operation that is in progress will not be affected. We 
recommend that you do not allow using the same user identity from multiple workstations. 

The UDDI administration and user access interfaces provided through Novell iManager are 
recommended for a typical usage of 10 to20 users accessing the UDDI registry 
simultaneously. So, at higher loads you might experience slow responses.

The basic look-and-feel of the utility differs from one browser to another, including the 
following:

Fieldsets (for example, the Inquiry and Publish fieldsets on the Set Rights for UDDI Base 
Context page in the Access Management).

Tabbed options.

Width of the list boxes (combo boxes).

Size of the frames and relative separation.

Changes in the GUI appearance within a fieldset are not displayed (such as changing the 
label of a control or enabling/disabling a button). However, the functionality remains in 
tact.

For instance, this happens when you check the Public check box on the Set Rights for 
Base Context page in the Admin Access Management. The Object Selector should be 
disabled. Functionally, this disabling occurs, but it is not visible to the user.

On Netscape Navigator 7.0, only a single object can be selected using the Object Selector 
icon. 

On Netscape Navigator 7.0, the online help icon is displayed if you are using iManager 1.5.1 
or later.

The XLDAP servlet cannot be removed after upgrading the UDDI Services running on 
exteNd Application Server to Novell Nsure UDDI Server. You can ignore this because the 
memory utilization by the XLDAP servlet is negligible. 

If you import business services that exceed the specified user quota, an error message is 
displayed. After you click OK, the Update Business Information page is displayed with the 
Services tab enabled. But the information displayed in the lower frame is Names although the 
functionality remains. Click any of the tabs to view the related information.

If you import binding templates that exceed the specified user quota, an error message is 
displayed. After you click OK, the Update Binding Information page is displayed with the 
Bindings tab enabled. But the information displayed in the lower frame is Descriptions 
although the functionality remains. Click any of the tabs to view the related information.

To uninstall the NetWare integrated installation, you must manually delete the novelluddi 
folder in the Tomcat_home\webapps\ directory. Also delete the sys:\uddi directory.
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Previous NetWare 5 NSS Volumes Not Automatically Upgraded

Previous NetWare® 5 Novell® Storage Services (NSS) volumes are not automatically upgraded 
during the NetWare 6.5 installation process. After you install NetWare 6.5 and reboot the server, 
you can upgrade pre-existing NSS volumes to the current NetWare 6.5 NSS volume layout. 

Before you upgrade previous NSS volumes, make sure that Novell® eDirectoryTM is running and 
that the Backlink process is complete. (For instructions, see Upgrading NetWare 5 Volumes Using 
Volume Copy Upgrade in the Novell Storage Services Administration Guide for NetWare 6.5.)

To upgrade previous NSS volumes: 

To upgrade a single NSS volume: At the server console, enter

nss /zlssvolumeupgrade=volume 

To upgrade all NSS volumes: At the server console, enter

nss /zlssvolumeupgrade=all

After you upgrade the volumes, you can either use the Mount All command or mount the volumes 
individually.

This issue does not apply to NSS volumes in clusters. The cluster automatically calls 

nss /zlssvolumeupgrade

to perform the upgrade.

Must Add Trustee Rights to Sys:login When Upgrading Volume Sys:

You can use the volume conversion utility called Volume Copy Upgrade (VCU) to upgrade a 
traditional volume sys: to the NSS volume sys:. However, the implied trustee rights do not transfer 
with this method. After you upgrade volume sys:, you must manually add a public trustee with 
Read and File Scan rights to the sys:login directory.

Junction Levels Limited on Windows Systems for DFS

On Windows XP and 2003, DFS works only one junction level deep. 

On Windows 98, NT 4, and 2000, the junction levels can be as deep as are supported by the length 
of a Windows path.

The NCPTM Client now supports DFS junctions at multiple levels deep on any Windows operating 
system.

Hot Fix Support

Novell Hot FixTM support has been removed from NetWare 6.5 because it is no longer necessary; 
storage devices typically provide their own hot fix solutions.
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Most NSS Storage Management Functions Moved to iManager and NSSMU

Effective in NetWare 6.5, you can perform most storage management functions only in iManager 
and the NSS Management Utility (NSSMU). Storage management functions are no longer 
available in ConsoleOne®. Storage interfaces in ConsoleOne refer you to the browser-based 
iManager and the console-based NSSMU for NSS storage objects or to NetWare Remote Manager 
(NRM) for Novell Traditional File System storage objects.

Exceptions to this change are the interfaces for setting up the DFS Management Context and 
Junctions and viewing the NSS Volume Location Database (VLDB) servers. These options are still 
in ConsoleOne.

This change does not affect Novell Cluster ServicesTM options in ConsoleOne.

Refreshing an iManager Page

To refresh the page you are viewing in iManager, click the link to that page in the left-hand 
navigator. 

If you click the browser’s Refresh button or Back button, the browser returns you to the initial 
iManager page that is retrieved upon login.

Specifying VLDB Servers for the DFS Management Context

In NetWare 6.5, you can specify up to two VLDB servers in the DFS Management Context and 
they must be in the same LAN. Because ConsoleOne does not log in to the VLDB server 
automatically, your setup might not take effect.

To avoid this problem, connect to the servers before you designate them as VLDB servers. For 
example, map drives from the servers to your local workstation or server where you are working. 
Then, simply select the servers to be your VLDB servers as you create the DFS Management 
Context.

You can also run ConsoleOne directly on the server that you want to make a VLDB server when 
you are setting up VLDB servers for your DFS Management Context. To add a second server, run 
ConsoleOne on that server, open the server’s property page, then click Add Replica.

ConsoleOne File Menu Issue for the DFS Management Context

The File menu on the ConsoleOne main toolbar allows you to create a DFS Management context 
in a container that is already defined as a DFS Management context. The option should be greyed 
out for a container that is already configured as a management context.

Start VLDB Repair from the Server Console after Creating a DFS Management Context

If you are creating a DFS Management Context using ConsoleOne, you must start the VLDB 
Repair command from the server console immediately after creating the DFS Management 
Context; do not start it from ConsoleOne. This is particularly important if you have servers and 
volumes in different containers in the tree because the server you start VLDB Repair on must be 
a VLDB server.

If started in ConsoleOne, the VLDB Repair logs in to eDirectory as the server that ConsoleOne is 
running on, and that server might not have sufficient rights to do everything it needs to do. If you 
attempt to create a new junction on a server in the tree that is not a VLDB server, you might get 
this error: 

The junction, junctionname, could not be created because 
servername_volume.context does not contain the DFS attribute.
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If started from the server console, VLDB Repair prompts for a username and password and then 
runs as the user as it walks the tree.

The need for manually starting VLDB Repair will be fixed in a later Support Pack release when 
VLDB administration is removed from ConsoleOne and supported in iManager.

Disable Login on a Server before Using Move Volume or Split Volume

The NSS Move Volume and Split Volume commands do not track any changes made to files that 
might be in use during the Move or Split job. Any such changes are lost.

For example, a file might be changed after the original file is copied to the new volume but before 
it is deleted from the original volume. Any changes made during that time are lost. 

Another example is if the original volume has the attribute set for File-level Snapshot. Because the 
Move and Split functions make use of the Storage Management ServicesTM (Novell SMSTM) 
backup and restore utilities, the File-level Snapshot attribute would automatically enable SMS to 
copy old versions of files from the original volume to the new volume even if they are in use during 
the transfer. Any of the changes made to the files during that time are lost.

To avoid losing changes made to files during a Move or Split job, keep users and applications from 
using the original volume while the job is running.

For example, issue the Disable Login command from the console to keep users from logging in to 
the server, then use NetWare Remote Manager (NRM) to issue a Drop Connections command to 
kill any active connections. 

Alternatively, you might issue an advisory to users to request their voluntary cooperation for the 
duration of the Move or Volume job. Make sure to address any active APIs that interact with the 
volumes.

Volumes Must Have an eDirectory Volume Object to Use DFS

In previous versions of NetWare, DFS allowed you to move or split volumes whether they had a 
corresponding eDirectory Volume object or not. In NetWare 6.5, volumes must have an eDirectory 
Volume object to be usable with DFS. For example, if you create a DFS junction manually in 
ConsoleOne, you specify the destination volume for the data by selecting its eDirectory Volume 
object.

Typically, whenever you create an NSS volume, NSS creates a corresponding eDirectory object. 
It would be unusual not to have an eDirectory Volume Object for your volume. 

If you ever need to update the volume’s eDirectory Volume object:

1 In iManager, click Storage Management > Volumes. 

2 Select a server.

3 Select the volume.

4 Click Update eDirectory.

Purge the Source Volume Manually after a Volume Move

If you move a volume, the Move Volume job does not automatically purge the source volume when 
it is done. To free the space, you must manually delete and purge the source volume after the Move 
Volume job completes successfully. The Split Volume job does purge the files that it deletes, so no 
additional action is required for a Split.
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Pool Multiple Server Activation Prevention

If enabled, the pool Multiple Server Activation Prevention (MSAP) prevents some accidental 
activations of a pool on more than one server at a time. It will not catch all multiple activations. 
You should never purposely attempt to activate a pool on two servers at the same time. MSAP is 
not meant as a replacement of clustering software that controls shared pools.

In some cases, the MSAP software causes pools to take up to 30 seconds to activate. This delay 
might occur on the next pool activation after the Server ID or the Cluster ID changes for a given 
server pool. The Server ID changes if the registry is corrupted. The Cluster ID changes if the 
Cluster NDS® object ID is lost.

If MSAP is enabled, all active ZLSS pools will be read every 14 seconds. If your storage media 
are not shared between multiple servers such as in a SAN, you can clear the zpool_feature_msap 
bit. You should not clear this bit if your pools are on physically shared storage media.

If a pool can be accessed by older servers not running the Support Pack with the MSAP software, 
then multiple pool activations can still occur.

MSAP does not protect against partition conflicts for pools. It does not prevent multiple servers 
from creating a pool in the same partition.

Segment Size Limitations

The size of a given segment cannot exceed 2 terabytes (TB). If you want to create an 8 TB pool or 
volume, you must use at least four segments when you create the pool.

The segment size for software RAID 0 and 5 devices is limited to 1 TB. 

Software RAID 5 Is Not Supported in the Initial Release of NetWare 6.5

NetWare 6.5 includes infrastructure to support Software RAID 5, but Novell and third-party 
vendors will not support Software RAID 5 for the initial release of NetWare 6.5. Support for 
Software RAID 5 is planned to be included in NetWare 6.5 Support Pack 1. 

You should not use Software RAID 5 in a production environment until you have applied NetWare 
6.5 Support Pack 1. Meanwhile, you can familiarize yourself with the Software RAID 5 feature in 
a testing environment only.

NetWare 6.5 fully supports Software RAID levels 0 and 1.

Turn OpLocks Off for Btrieve-Based Applications

If you are using Btrieve-based applications on your server, you must turn off opportunistic locking 
(OpLocks).

To turn OpLocks off on a server, enter the following at the server console:

set Level 2 OpLocks Enabled = off

set Client File Caching Enabled = off

To turn OpLocks off on a workstation:

1 Right-click the Novell ClientTM icon (the red N) in the system tray.

2 Click Novell Client Properties > Advanced Settings.

3 From the Parameter Groups list, select File Caching.

4 In the Setting field, select Off from the drop-down list.
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5 Click OK.

6 Reboot your workstation.

Imaging NetWare Partitions

NetWare partitions that are restored by some imaging utilities might cause the volumes to not be 
seen. When imaging NetWare 6.0 and 6.5 partitions, the imaging utility must be aware of the 
partition segments within NetWare partitions. 

The Portlock imaging utility is compliant and will function properly. With other utilities, the 
partition must be restored to the same starting sector on the disk as it was imaged from; if not, the 
pools and volumes will not be seen. You can also image the entire disk and restore the entire disk.

Mounting a USB Floppy Disk As a Local FAT Volume

If your server uses a USB floppy drive, NetWare 6.5 does not mount floppies automatically during 
the server installation. You might need to manually mount a floppy disk to install the NetWare 6.5 
license. 

Local File Allocation Table (FAT) volumes are available to the server but are not seen by users. By 
default, NetWare 6.5 does not automatically mount local FAT volumes such as the floppy disk in 
a USB floppy drive. Use the Local Fat Volume Mount (LFVMount) command to detect and mount 
any local FAT volumes not recognized by DOS and assign them a local drive letter. 

To mount local FAT volumes, enter the following at the system console prompt:

lfvmount

The LFVMount command affects only the current local FAT volumes. For example, you must re-
enter this command each time you change a floppy disk in the USB floppy drive. 

Use the associated SET parameter (set auto lfvmount=<on | off (default)>) to configure automatic 
detection. If set to On, NetWare automatically detects and mounts local FAT volumes as you insert 
the media into the drive and then assigns drive letters to them. If set to Off (default), NetWare does 
not automatically detect and mount local FAT volumes; you must use the LFVMount command to 
manually mount them as needed. 

To automatically mount local FAT volumes for a server, enter the following at the system console 
prompt:

set auto lfvmount=on

To prevent the automatic mounting of local FAT volumes for a server, enter the following at the 
system console prompt:

set auto lfvmount=off

If entered at the system console, the associated SET parameter remains in effect until you change 
it or until you reboot the server.

To make the SET parameter persistent through a server reboot, add one of the following commands 
in the startup.ncf file:

set auto lfvmount=on

set auto lfvmount=off

If no value is set in the startup.ncf file, NetWare does not automatically mount the local FAT 
volumes. You must use the LFVMount command to manually mount local FAT volumes as 
needed.
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The Local Fat Volumes (lfvolumes) command displays a list of local FAT volumes that are 
currently mounted and provides detailed information about them.

To list information about local FAT volumes mounted on the server, enter the following at the 
system console prompt:

lfvolumes

The LFVMount command appears in the console-based help for console commands. 

For help with the LFVMount command, enter one of the following at the system console prompt: 

help mount

help lfvmount

Handling of a Corrupted Transaction Tracking System Log File

If a system failure occurs, the NSS Transaction Tracking SystemTM (TTSTM) replays the TTS log 
file to recover lost application-based transactions as part of the failover recovery. 

Before replaying the TTS log to recover lost transactions, TTS checks the integrity of the 
transaction file blocks in the log. If TTS detects no problems, the replay continues.

If TTS detects a bad block, it does not use the log file. TTS creates a new TTS log file to use as 
the system continues to operate. 
IMPORTANT: Although the system continues to run, data might have been lost. 

TTS renames the corrupted TTS log file to indicate the date and time that it detected the problem. 
For example, it renames

volume:\UXaction.log 

to

volume:\XLogyyyymmddhhmmss.log

Corrupt TTS log files are relatively large, about 10 MB. TTS stores the corrupt TTS log file in the 
root directory of its transactioned volumes. If users report finding TTS log files in the root 
directory of their volumes, it indicates that a problem occurred and that TTS detected it. 
NOTE: If a system failure causes corruption in the TTS log file, please report to Novell Technical ServicesSM 
the network circumstances that lead to the corruption of the TTS log file. We would like to examine the event 
to find why the corruption might have occurred.

NSS Read Ahead Maximum Block Count

The NSS Read Ahead maximum block count is 128 blocks. 

If the Read Ahead attribute is set for a volume, the NSS file system allows for an adjustable read 
ahead specified by volume. The default read-ahead block count is 2 blocks (8 kilobytes). Currently, 
the valid values range from 0 blocks (meaning no read ahead) to 1024 blocks. However, the 
practical maximum value is 128 blocks. Block counts greater than 128 can starve other system 
components for memory or buffers, which can result in poor performance or system hangs. As the 
number of concurrent connections to unique files increases for a volume, you should reduce the 
volume’s read-ahead block count accordingly.
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35 Novell TCP/IP

Fault Tolerance

Fault tolerance is supported on Open Data-Link InterfaceTM (ODITM) compliant drivers, such 
as CE100B, IBMFE, PCNTNW, 3C90XC, and N100.

Fault tolerance does not work for multicast applications. When the NIC which contains the 
multicast group address information goes down, the multicast group address information is 
not transferred to the other members in the group. For example, applications like SLP will not 
work when the associated NIC goes down.

Per-Packet Load Balancing 

To maintain communication, the card properties (such as checksum, offloading, and support) 
should be the same.

All cards on the same network should be grouped; otherwise, the packet will also reach an 
ungrouped member.

Virtual IP

Virtual IP currently works only in an environment configured for RIP-based routing.

Virtual IP will not work with applications that time out before the Routing Expiration Time 
Out Interval. Therefore, the applications will not get a chance to switch to the next-best hop 
for the route. For example, NCPTM and GroupWise® applications will time out before the 
routing expiration takes place and they will need to re-establish their connections. 

Secondary IP Address

When INETCFG/Web-based TCP/IP Configuration transfers TCP/IP related commands from the 
autoexec.ncf file, the command add secondary ipaddress x.y.z.w will not be transferred to 
tcpip.cfg.

Default Routing Configurations

IP packet forwarding is disabled. The NetWare server will work as an end node.

RIP is disabled. The server will not be able to learn and send any RIP routes.

LAN Static Routing is enabled. 

Web-based TCP/IP Configuration

The following configurations are not supported in the Web-based TCPIP configuration 
(nirman.nlm) through NetWare® Remote Manager (NRM): 

User-specified protocol (NIC Teaming)

BOOTP
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EGP

SNMP
NOTE: Click the Configure TCPIP link in the left pane of the NetWare Remote Manager main page to access 
the Web-based TCP/IP configuration utility.

NIC Teaming

Currently, only one user-specified protocol is supported.

Configuration through INETCFG

If the netinfo.cfg file is corrupted and upon loading INETCFG you get a message asking you 
to reconfigure, delete the tcpip.cfg file.

After the network configuration of the server is complete, we recommend that you back up 
the netinfo.cfg, netinfo.chk, and tcpip.cfg files located in sys:\etc. Then, in case of corruption, 
you can restore from the backed-up configuration.

In machines with multiple NICs, when already-in-use IP addresses are selected for binding, 
an ARP conflict error message for each binding is displayed in the system console screen. The 
system should automatically trigger unbinding of the IP addresses. If the binding persists,               
manually delete the bindings and reinitialize the system.

Supernetting

After a server is configured as a router (forwarding enabled), it cannot be configured with a 
supernet mask. Therefore, if a server is configured with a supernet mask, forwarding is 
disabled. 

If the mask is changed to a nonsupernet mask and the system is reinitialized, the INETCFG 
protocol configuration indicates that forwarding is enabled even though it is not. To re-enable 
forwarding, you need to make an explicit configuration change in INETCFG.

To verify the status of forwarding, check the Forwarding tab in TCPCON. 

Pragmatic General Multicast (PGM)

PGM is a reliable multicast transport protocol that works on a multicast-enabled network. 
Therefore, the network from the PGM sender to all the PGM receivers should be multicast enabled. 
If there are any routers on the path between the sender and the receivers, multicast forwarding must 
also be enabled on them.

Ipflt.nlm

If more than one board is bound to the same IP address, the filter should be configured for all 
boards; otherwise, filtering will take place only for the configured member. 

Iptrace.nlm

The iptrace.nlm program will not be able to display the information of traces where destination 
addresses and intermediate hops do not respond to the source. 

Routecon.nlm

Currently, the routecon monitor option is not supported.
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36 Nsure Audit

Novell® Advanced Audit Service does not ship with NetWare® 6.5. It has been replaced by 
Novell NsureTM Audit.

AuditNW must be loaded after any antivirus product; otherwise, the server might appear to be 
hung and will have to be hard-reset.

Directories or files created by Macintosh* computers and stored on a NetWare volume using 
the Mac* name space that are approximately 450 characters or longer might cause an abend 
if events are being logged against the file system.

By default, no NetWare or file system events are being logged.

We recommend that only one Secure Logging Server be installed per system and that other 
servers be configured to log events with this server. Depending on the number and type of 
events to be logged throughout the system, a dedicated Secure Logging Server should be 
considered.
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37 Nterprise Branch Office Appliance

For issues related to Novell® NterpriseTM Branch OfficeTM, see the Readme (http://
www.novell.com/documentation/lg/nbo/index.html?page=/documentation/lg/nbo/readme/data/
agfitbb.html) located with the Nterprise Branch Office online documentation (http://
www.novell.com/documentation/lg/nbo/).
IMPORTANT: Before installing a central office NetWare® 6.5 server and installing Nterprise Branch Office on 
appliance hardware, you should familiarize yourself with Nterprise Branch Office and specific requirements for 
the central office server. See the Nterprise Branch Office online documentation (http://www.novell.com/
documentation/lg/nbo/).
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38 NTPv3 RFC 1305

NTPv3 contains the following utilities:

XNTPD

NTPQ

NTPTrace

NTPDate

XNTPDC

By default, Timesync is loaded with the NetWare® 6.5 installation. To make XNTPD load by 
default, edit the sys:\system\timeserv.ncf file.

Known Issues

XNTPD accepts only lowercase letters in the ntp.conf file.

You define a configuration file using the -c command. However, NetWare Remote Manager 
does not understand this user-defined configuration file, and it opens the default ntp.conf file.

If you are unable to open the ntp.log file using Edit, use NetWare Remote Manager. You can 
also unload xntpd.nlm and try opening it again. This is a very rare issue and normally you 
should be able to open the ntp.log file without any problems.

The system console might hang if you specify an incorrect IP address with NTPDate and try 
to unload NTPDate abnormally. To avoid this, wait for NTPDate to exit normally.
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39 OpenSSH on NetWare

Error Reported during Remote Upgrade

If you perform a remote upgrade, OpenSSH will report an error trying to configure the product.   
To fix the configuration problems, edit sys:\etc\ssh\sshd_config and update the default <Your-
Context> tag with the admin user's context. You will also need to add users who you want to have 
rights to administer OpenSSH to the sshadmn-Administrators group.

A local (from the GUI on the server) post-install of the OpenSSH product will also correct the 
configuration issues.

Supervisor Trustee Rights Required to Access Server Console

Only users who have supervisory trustee rights to the NCPTM Server object can access server 
console screens from an ssh client. Previously, any admin user or user with admin-equivalent 
rights could access the server. The new method allows administrative users to give a user rights to 
access the console screens without granting him complete admin privileges.

User Objects Do Not Have uniqueid Attribute after Upgrade

After upgrading from a NetWare® 5.1 server with eDirectoryTM 7.x to a NetWare 6.5 server (which 
upgrades eDirectory to version 8.7), User objects don't have a uniqueid attribute which is used by 
sshd for authentication, so sshd falls back to the cn attribute. The cn attribute, however, is no longer 
public after the upgrade. Therefore, the admin user must make the cn attribute public in 
ConsoleOne® or iManager. 
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40 Pervasive.SQL

Insufficient Memory Might Cause a CPU Hog Abend

If Btrieve* doesn’t have enough memory allocated when it’s loaded on the NetWare® server, it 
could result in a cpu hog abend. The abend information will indicate that nwmkde.nlm abended in 
GetCacheBuffer.

The default memory requirement is 2 MB. However, Pervasive* recommends at least 10 MB 
(preferably 20 MB). 

You can increase the Btrieve memory requirement in the sys:system\bti.cfg file by modifying the 
CacheSize=2024 parameter.

Pervasive.SQL 2000 Database Licenses

A permanent two-user license is installed during the NetWare 6.5 installation process. If you are 
upgrading an existing NetWare server, an unlimited license that will expire 90 days after 
installation is also installed. 

The permanent two-user license is intended for use by the NetWare operating system. If you have 
additional applications using Pervasive.SQL 2000 or Pervasive.SQL 2000i, including the Btrieve 
interface, you can use the unlimited user count license for 90 days. If you have applications that 
need access to the NetWare Pervasive.SQL 2000i database engine, you must purchase an 
appropriate user count license from Pervasive Software before the 90-day evaluation period ends. 
Allow adequate time before the end of the evaluation period to receive your user count license.

For more information on Pervasive.SQL 2000i and its features, documentation, or information:

Internet: Pervasive Software Web site (http://www.pervasive.com) 

Email: Salessupport@pervasive.com

Phone (U.S.): 1-800-287-4383

Phone numbers for all international offices are available from the Contact Us link (http://
www.pervasive.com/company/contact/index.asp) on the Pervasive Software Web site.

Known Issues

In order for Pervasive to update known issue reports between releases, all Known Issues are 
published in the Pervasive Knowledge Base (http://support.pervasive.com/eSupport/). Search on 
Pervasive.SQL 2000 Service Pack 3 known issues.

You can also see a static list of known issues, including links to the associated Knowledge Base 
articles, at the Fixed Defects and Known Issues Web page (http://www.pervasive.com/support/
updates/psql2kfixed.asp).
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Technical Support

For technical support and discussions about Pervasive products, see the DevTalk forum (http://
www.pervasive.com/devtalk).

To file a support incident, submit an Electronic Support Incident (http://www.pervasive.com/
support/support_email.asp).

You can also visit the Pervasive Support Center (http://www.pervasive.com/support/
supportcenter.asp) for other contact information.

Useful Links

Comprehensive list and details of Pervasive products (http://www.pervasive.com/offerings)

Discussions about Pervasive development issues (http://www.pervasive.com/devtalk)

Technical papers (http://www.pervasive.com/support/TechPapers.asp)

Online product manuals (http://www.pervasive.com/support/technical/online_manuals.asp)

Support programs (http://www.pervasive.com/support/support_programs.asp)

Pervasive Knowledge Base (http://support.pervasive.com/eSupport/)

Updates and patches (http://www.pervasive.com/support/updates/)
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41 Scripting Products

Scripting Products Included

The following scripting products are included with NetWare® 6.5. Additional Readme information 
is located on the Novell® Developer Web site:

PHP (http://developer.novell.com/ndk/readme/php.txt)

Perl for NetWare (http://developer.novell.com/ndk/readme/perl5.txt)

Novell Script for NetWare® (NSN) (http://developer.novell.com/ndk/readme/nscript.txt)

Universal Component System (UCS) (http://developer.novell.com/ndk/readme/ucs.txt)

Upgrading from NetWare 6.0 to NetWare 6.5

NetBasic* 6.0 is not installed as a part of NetWare 6.5. If you are familiar with NetBasic 6.0 and 
shell commands, use NSNINIT and NSNSHELL instead.

PHP

Some of the open source applications cannot be executed because the open_basedir option is 
enabled in this release. Do one of the following to execute the open source applications:

Edit the open_basedir entry in the php.ini file located in the sys:\php directory.

Disable the open_basedir option.

For more information, see the PHP documentation (http://developer.novell.com/ndk/doc/php/
php__enu/data/ajdnlr0.html) on the Novell Developer Kit Web site (http://
developer.novell.com/ndk) and the PHP manual (http://www.php.net/manual/en).

UDP functions are not yet stable and might cause the server to abend.

If fsockopen() fails, a memory leak and abend might result.

The Mail functionality will not work if the SMTP Server Name is specified instead of the IP 
address for the SMTP variable under the [mail function] section in php.ini file.

When an infinite or a recursive script is run from one browser, running even a simple script 
from another browser simultaneously might abend the server.

Stopping an infinite script by unloading Apache at the server console might cause the server 
to hang or abend.

Sorting using string indices might not work properly.

The strtotime() function might not work properly.

For the system() and exec() functions, we recommend that you use only single-quoted strings 
with any combination of slashes to separate directories. For example:

system('sys:\system\rconag6.nlm'); or system('sys:\\system\\rconag6.nlm');
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If double-quoted strings need to be used, then use a double slashes. For example:

system("sys:\\system\\rconag6.nlm");

If double-quoted strings are used with single slashes and if the NLMTM name starts with the 
letter r, t, or n—for example, system("sys:\system\rconag6.nlm");—then the NLM will not 
load.

This is because the letters will be considered as \r or \t or \n.

Perl for NetWare

Failure of UCX methods will be indicated by an unknown error. The error description given 
by the UCX call is currently not available for the Perl script.

If a script has just use Perl2UCS or require Perl2UCS and no object instantiation through 
Perl2UCS->new(...), then the script will abend.

Scripts that contain an infinite loop can be terminated by Ctrl+z, but not Ctrl+c. When Ctrl+z 
is pressed, it breaks the loop and expects any key to be pressed (which will be indicated on 
the Perl output screen) before the Perl output screen can be exited.

Press Ctrl+z after pressing Enter to execute the next command in the Perl debugger.

Scripts that use the Thread and Threads modules might not work as expected.

The truncate built-in procedure does not function reliably.

The readlink built-in procedure always returns an undefined value. 

According to Perl’s definition of the function, this is the correct behavior on a system such as 
NetWare that does not support symbolic links.

The Fork method is not yet implemented on NetWare.

The Perl extension to access components through UCS was named UCSExt in Perl 5.003. 
With Perl 5.6 and later, it is renamed as Perl2UCS. So, in order for the components to work, 
change UCSExt to Perl2UCS.

We recommend that you use the perl system("nlmname") without the load prefix to load an 
NLM. However this NLM load method does not update the $? variable.

The SYN_TIME NDS attribute returns a string value, but Perl sends double value while 
setting such attributes representing seconds since 1970.

For NetWare 6 and later, executing command line options causes output to be displayed on 
the logger screen.

Setting Alias to a directory other than sys:/perl/web might result in non-execution of scripts. 
We recommend that you use the default alias directory represented in the mod_perl 
configuration file (mod_perl.conf).

Novell Script for NetWare

The date data type for the MySQL Parameter object is not supported in this release.
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Universal Component System

NSN and Perl scripts using UCS2UCX and UCS2 Perl extensions will not get executed from 
the server console. These scripts can be executed from the browser.

UCS2Java (Java Provider)

In UCS2Java provider, complex data types like Date and Array are not fully supported.

When the script executes, the control will go to the Java GUI screen if the DISPLAY 
environment variable is set to the default value (127.0.0.1:0). For the control to go to the 
Console screen, set the value to 127.0.0.1:1 by entering the following command at the 
console:

ENVSET DISPLAY=127.0.0.1:1

AWT-based JavaBeans* might cause the script to hang while exiting. This is due to a 
problem in JNI, which does not allow the VM to unload if threads are still running.

Final variables in classes (equivalent to constants) are not currently supported.

Java objects cannot be instantiated using constructors with parameters. Only the 
constructor with no parameters will be called.

UCS2RMT/UCS2WIN (Remote ActiveX Provider)

If some ActiveX Controls are not compliant to the standard, it might cause some problems.

Java2UCS (Java Extensions)

Due to recently incorporated security features in many of the UCX components, many of them 
will not be fully usable from Java programs using Java2UCS. A solution will be available in 
the near future.
Scripting Products 107



Novell Confidential scripting.fm last saved  8/25/03 Manual Version: 3/17/03103
108   NetWare 6.5 Readme



Manual (ENU) 3/17/03103Novell Confidential server_operating_system.fm last saved  
42 Server Operating System

Down Command Powers Off Server on Most Pentium 4 Machines

On newer server hardware that provides ACPI (Advanced Configuration and Power Interface) 
support, NetWare® 6.5 auto-detects and loads the acpidrv.psm module that supports 
HyperThreading, if present, and advanced Power Management features.

With the ACPI power management drivers loaded (which they are by default if the hardware 
support is detected), pressing the server's power button executes the DOWN command (bringing 
down the server with a 30-second default delay and a message) and then powers the server off.

Actually executing the DOWN command at the System Console prompt or from NetWare Remote 
Manager, also shuts down the server and powers off the system.

The RESTART SERVER command includes a power cycle on these same machines with ACPI 
support, equivalent to the RESET SERVER console command.

Resolving Hangs That Occur during Server Startup

If the server appears to be hung during the first stages when the drivers from the startup.ncf file 
are loading, check the System Console for the following messages on the most recent screen:

Queuing error message for later.

or

Processing stage 1 loading of NLMs.

Several of the following actions or problems could cause the hang and messages to occur:

You have made changes in the startup.ncf file that removed a necessary storage driver or 
Custom Device Module (CDM) drivers; specified incorrect slot numbers; or changed the 
loading order of PSM, CDM, or HAM storage drivers.

You have changed hardware and not changed the startup.ncf to reflect the changes.

The storage adapter or drives experienced a hardware failure.

If you suspect that the hang was caused by any of these actions or problems, enter the following 
command at an alternate console prompt (press Ctrl+Alt+Esc and enter 3 to spawn a new 
command line process).

LFVOLUMES RESET STATUS

The status shows the drive letters (local volumes) that the system is trying to access via real mode 
interfaces. If any drives are listed, then the hang condition encountered might be the result of the 
system waiting for a NetWare driver to report the availability of that local volume and, for some 
reason, that event isn't happening.
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To resolve this hang:

1 At the alternate console prompt, enter

LFVOLUMES RESET

This informs the operating system that for this boot instance it is allowed to continue 
accessing local volumes using the real mode interfaces instead of waiting for access through 
a NetWare driver.

2 When the System Console prompt is available, try to discover why the storage drivers did not 
load or initialize correctly. 

Possible options include:

Reviewing the Logger screen for errors reported while loading drivers

Running HDETECT to ensure the contents of the startup.ncf file is correct

Ensuring that the system's disk subsystems are configured correctly

3 Correct the suspected problem and restart the server to ensure that it will run without startup 
errors.
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43 Storage Management Services (SMS)

Windows Target Service Agent and NWBACK32 Support

Novell® has discontinued support for the file system Target Service Agent components for 
Windows and NWBACK32.

TSAFS Module

The file system Target Service Agent for NetWare® 6.5 (TSAFS) is redesigned to scale with 
optimized hardware configurations for better performance. It is compatible with all the existing 
backup engines and provides tunable parameters to fine-tune performance. 

TSAFS Issues
NOTE: With this release, the Target Service Agent naming convention reflects the supported target service 
and the Target Service Agent for the NetWare file system is called TSAFS.

During a restore of NFS hardlinks, the data and the metadata of the first link are restored. 
Other hardlinks currently are not created.

When a volume is renamed, TSAFS does not automatically refresh the volume list. Reload the 
TSAFS to refresh the volume list.

When the TSAFS is unable to restore the name in a particular name space, an appropriate 
message will be logged. In this case, the file system automatically generates the name in that 
name space.This name might be different from the one that was backed up, if the name in that 
name space was modified specifically after it was created.

For example, if the TSAFS is not able to set the MACNameSpace for a particular dataset, the 
following message is logged.

Unable to set the data set name in MACNameSpace for sys:perl/
webdemo/perldocs directory. Restore will continue processing the 
data set name in other name spaces.

When backing up a compressed volume in uncompressed format, ensure that the server has 
enough space in the volume to accommodate the uncompressed data.

Other Issues

During restore, the file system resolves name conflicts in the DOS name space and generates 
DOS names for files and directories. As a result, the DOS name of the restored file might not 
be the same as the one that was backed up. 

For example, a file filename1.htm with the DOS name filena~1.htm might be restored as 
filena~2.htm.

If you select a single file for backup, you cannot use SBCON to rename it during a restore.
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Discovery through Novell eDirectoryTM (NDS®) is no longer supported in SMDRs. Discovery 
through SLP and SAP is supported.

SMDR listens to only the default IP address of the server even if there are multiple IP 
addresses.
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44 Third-Party Adapters, Drivers, and Applications

Hewlett Packard SmartStart

SmartStart* versions earlier than version 7.00 are not supported in the deployment of NetWare® 
6.5. Updated driver, Health, and Management agents will be available in the ProLiant* Support 
Pack (PSP) for NetWare version 6.41 or later, which is available on the Hewlett Packard* Web site.

If versions earlier than SmartStart 7.00 or PSP 6.41 are used, ensure that all of the Health and 
Management agent modules have been removed from the c:\nwupdate subdirectory prior to 
restarting the server and ensure that all of the health and agent load lines have been removed from 
the autoexec.ncf file.

For updates to SmartStart and the ProLiant Support Pack, check with your Hewlett Packard 
representative or the Hewlett Packard Web site.

Symantec Norton Anti-Virus v8

Symantec* Norton Anti-Virus* v8 is not supported on NetWare 6.5. Contact your Symantec Sales 
Representative to purchase the upgrade (v8.1) in order to continue to run Symantec NAV on 
NetWare 6.5. For detailed information, access the Novell KnowledgeBase (http://
support.novell.com/search) and enter TID #10085603.

SMS Compatibility with Third-Party Backup Software

The Novell® SMSTM components in NetWare 6.5 were tested with the following:

ARCserve* 9.0 for NetWare

VERITAS* Backup Exec for NetWare version 9.0

VERITAS NetBackup DataCenter 4.5 GA

Syncsort Backup Express version 2.1.5c

CPQSHD.CDM Driver

If servers running CPQSHD.CDM experience any drive deactivation issues, it is possibly caused 
by the CPQSHD.CDM. We recommend that you check with your Hewlett Packard representative 
or the Hewlett Packard Web site for timely updates to this driver.

QLogic QLA2x00 HAM Driver

For detailed information on the QLogic* QLA2x00 HAM Driver for NetWare 4.x, 5.x, 6.x, access 
the Novell KnowledgeBase (http://support.novell.com/search) and enter TID #10085142.
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ISA Adapters Are Not Supported

For performance and scalability reasons, all ISA adapter drivers were removed with the NetWare 
6.0 release. There is a possibility that a family driver might support adapters which run on more 
than one bus type (PCI and ISA). In this case, any ISA adapter would be considered a noncertified 
driver and would not be supported by Novell.

Promise Adapter Support

The drivers that support the Promise* FastTrak S150 TX2plus and SATA150 TX2plus cards do 
not support CD-ROM drives.

HighPoint Adapter Support

NetWare does not currently support HighPoint adapter cards or integrated controller chipsets.

Software RAID 5 Is Not Supported in the Initial Release of NetWare 6.5

NetWare 6.5 includes infrastructure to support Software RAID 5, but Novell and third-party 
vendors aren’t supporting Software RAID 5 for the initial release of NetWare 6.5. Support for 
Software RAID 5 is planned to be included in NetWare 6.5 Support Pack 1. 

You should not use Software RAID 5 in a production environment until you have applied NetWare 
6.5 Support Pack 1. Meanwhile, you can familiarize yourself with the Software RAID 5 feature in 
a testing environment only.

NetWare 6.5 fully supports Software RAID levels 0 and 1.

SCSIHD.CDM Command Line Options

SCSIHD.CDM now has command line options that can customize the behavior of the driver. The 
following is the syntax:

load scsihd <</>option<=value>>

Option Explanation

? Displays the help screen. Can be used only when the driver is not 
loaded (the loader cannot load it if it is already loaded). 

When this option is used, the help screen is displayed on the console 
screen in NetWare 4.x and NetWare 5.x and on the logger screen in 
NetWare 6.x, and the driver load fails.

AEN Causes SCSIHD to issue Asynchronous Event Notification HACBs 
(AENs). This, in turn, causes the HAMs that can do so (such as fibre 
channel) to report the loss of a hard disk drive or the discovery of a 
new one even without active IO.

DEBUG Causes SCSIHD to output extra messages to the console screen 
(NetWare 4 and 5) or logger screen (NetWare 6).
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EXCLUDE=value Causes SCSIHD to not support a particular driver model. The model 
name specified in this option is compared with the Product ID field in 
the SCSI Inquiry data. The model name is case sensitive, and partial 
model names are acceptable as long as the truncation is not on the 
left. 

Replace value with the name of a hard drive model that you do not 
want SCSIHD to support. 

Maximum length of model name: 14 (decimal)

Default: Do not exclude anything

HELP Same as ?.

REQPOOL=value Causes SCSIHD to create a pool of buffers that can be used in 
addition to the one maintained by NWPA to create IO requests. In 
NetWare 4, performance is enhanced if the driver maintains its own 
buffer pool for requests. In NetWare 5 and NetWare 6, performance is 
faster if the driver uses NWPA’s request pool—unless NWPA's request 
pool frequently becomes depleted, in which case it is better to specify 
REQPOOL and have the driver maintain the pool. 

Overuse of this option unnecessarily uses up memory. This option 
should be used only by those who have a highly technical knowledge 
of NetWare.

Replace value with the number of buffers that SCSIHD should 
maintain in its pool before it tries to allocate new buffers from the 
operating system. 

Range: 1 to 99,999 (decimal)

Default: 0

RETRIES =value When an IO error occurs that is caused by hardware failure, SCSIHD 
tries to jumpstart the device back to life with a combination of Test Unit 
Ready and Start Device SCSI commands. If successful, SCSIHD 
retries the original request that failed; otherwise, the disk drive is 
deactivated to protect the data on it from corruption. 

Replace value with the number of retries that SCSIHD should attempt 
without success before it deactivates the drive. 

Range: 1 to 999 (decimal)

Default: 3 (decimal)

RETRYDELAY=value Between retries of the Test Unit Ready and Start Device SCSI 
command combination, SCSIHD delays for the number of seconds 
specified by this option. 

If recovery of the failed device is not successful, the RETRYDELAY 
value multiplied by the RETRIES value determines the amount of time 
that a device is deactivated after the hardware error is reported. This 
time amount could be distorted by the HAM driver doing its own retries. 

Replace value with the number of seconds SCSIHD should delay.

Range: 1 to 999 (decimal)

Default: 10 (decimal)

Option Explanation
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IDEATA.HAM, IDEHD.CDM, and IDECD.CDM Command Line Options

IDEATA.HAM, IDEHD.CDM, and IDECD.CDM now have command line options that can 
modify the behavior of the driver or display certain kinds of information about the driver or storage 
interface. In each case where information is to be displayed, the driver will display the information 
on the Server Console Screen in NetWare 4.x and NetWare 5.x and on the Logger Screen on 
NetWare 6.x. Enter the following at the server console prompt to display a list of available options:

load ideata /?

load idehd /?

load idecd /?

Option Explanation

/? Displays the help screen, whether or not the driver is loaded. This 
option can be used in conjunction with other options to set those 
options, if the driver has already been loaded. 

For example, loading with "load ideata /? /nodma" after all instances 
of the driver have already been loaded will cause the driver to display 
the help screen and to disable DMA beginning with the next I/O 
transaction.

/break or /b Causes the driver to break into the debugger immediately after loading 
(IDEATA.HAM only). This option is available during installation.

/debug or /d Displays various errors as they occur. Also changes the numeric form 
of the verbose actions (detailed under /verbose) into text that is not 
listed here, but is detailed in TID #10085776 on the Novell 
KnowledgeBase (http://support.novell.com/search). 

Use /debug- or /d- to disable this option.

Default: Disabled

/global or /g Keeps an internal list of the last 64 driver actions. This list is stored in 
the global variable IDEATA_History in four-byte sections as 
BBDDHHXX, where BB is the registered bus number, DD is the 
registered device number, HH is the upper byte of the lowest word of 
the HACB (storage request) address, and XX is the action number, 
described in TID #10085776 on the Novell KnowledgeBase (http://
support.novell.com/search).

From within the NetWare Internal Debugger, these actions can be 
displayed by entering "dds IDEATA_History" at the debugger 
command line, but only if this option is first invoked. 

Use /global- or /g- to disable this option.

Default: Disabled
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/history or /h Keeps an internal list of the last 32 driver actions on the particular 
request. This list is stored in each HACB (storage request) in the HAM 
Space area beginning at offset 0x14 (offset 0x78 of the SuperHACB). 
Each byte in this list represents a driver action, described in TID 
#10085776 on the Novell KnowledgeBase (http://support.novell.com/
search).

Use /history- or /h- to disable this option.

Default: Enabled

/info or /i Displays certain or various technical information about the driver and 
storage interface, such as disk drives, device parameters, PCI 
Configuration information, and driver settings. 

Use /info- or /i- to disable this option. 

Default: Disabled

/noaen By default, the driver will issue or accept AEN (asynchronous event 
notification) requests and queue them until the specified event occurs. 
Using this option disables the use of AEN requests. Executing the 
/noaen option after the driver is loaded will have no effect on AEN 
requests that might have been queued up to that point. 

Use /noaen- to re-enable support for AEN requests. 

Default: Disabled (AEN requests are issued or accepted)

/nodma By default, the IDEATA.HAM driver will check the IDE hardware for 
DMA compatibility and execute DMA commands if they are supported. 
Using this option (IDEATA.HAM only) will disable all support for DMA 
transactions and cause all device communications to be done using 
PIO (programmed I/O). 

IMPORTANT: Using this option might cause significant performance 
degradation. Use /nodma- to re-enable support for DMA commands. 
This option is available during installation. 

Default: Disabled (DMA will be attempted)

/noint By default, the IDEATA.HAM driver performs I/O with the CPU 
interrupt flag in the state unchanged from when NWPA called the 
driver to perform the I/O, normally with interrupts enabled. Using this 
option (IDEATA.HAM only) disables interrupts during the entire I/O 
processing cycle. 

IMPORTANT: Using this option might cause significant performance 
degradation. 

Use /noint- to re-enable support for request handling with interrupts 
enabled. 

Default: Disabled (interrupts are not purposely disabled during the 
span of request processing)

Option Explanation
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/nomp By default, the driver accepts requests from multiple processors. 
Using this option disables the driver's ability to do so and causes all 
requests to originate from a single processor. 

Use /nomp- to re-enable the acceptance of requests from multiple 
processors. This option is available during installation. 

Default: Disabled (requests from multiple processors are accepted)

/nonative By default, the IDEATA.HAM driver attempts to switch the IDE 
controller to Native PCI Mode (as opposed to Compatibility or Legacy 
ISA Mode) if the controller indicates it supports the mode switch. Using 
this option disables the driver's ability to switch to Native Mode. For 
some types of controllers (such as RAID and Mass Storage) this 
switch has no effect because those controllers must run in Native 
Mode.

The /nonative- option is accepted, but it has little effect after the driver 
is loaded because the action of switching to Native Mode takes place 
only once, just after the driver loads.

Default: Disabled (the driver attempts to switch to Native Mode)

/noping By default, the IDECD.CDM driver accepts requests to check for 
media change. Using this option (IDECD.CDM only) causes the driver 
to ignore requests to check for media change. One implication of this 
option is that the operating system is not notified if a new platter is 
inserted into its CD-ROM drive. 

Use /noping- to re-enable the acceptance of requests that check for 
media change.

Default: Disabled (the driver accepts requests to check for media 
change)

/safe or /s Incorporates the /nodma, /noint, /nomp, /noaen, /global, /nonative, 
and /history options into a single option. Using this option 
(IDEATA.HAM only) causes the driver to execute requests in a manner 
that will help the user determine the cause of any problems.

IMPORTANT: Using this option might cause significant performance 
degradation. 

Using /safe- or /s- has no effect. 

Default: Disabled

/verbose or /v Displays each action for this driver. If this option is used with the 
/debug or /d option, the actions are displayed in text form; otherwise, 
they are displayed in numeric form. These these numbers are detailed 
in TID #10085776 on the Novell KnowledgeBase (http://
support.novell.com/search).

Use /verbose- or /v- to disable this option.

Default: Disabled

Option Explanation
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45 Time Synchronization (Timesync.nlm)

By default, Timesync is loaded during the NetWare® installation. To make XNTPD load by 
default, edit the sys:\system\timeserv.ncf file.

Known Issues and Limitations

Timesync in a forced scenario might not work in some setups.

To resolve this:

Set Timesync Configured Sources = ON

Specify the IP address, DNS name, or file server name of the time source in the Timesync 
Time Sources parameter. 

The Monitor screen hangs for a minute if an invalid IP address is given as the time source and 
the RESET flag is pressed.

Timesync fails to take time from NetWare 4.x if XNTPD is the default for time 
synchronization at server startup.

If you try to install a NetWare 6.5 server as a secondary time server (with default 
configuration) into a NetWare 4.x tree, time synchronization will fail on the NetWare 6.5 
server. 

To resolve this:

Give the file server the name of NetWare 4.x server in Timesync Time Sources 
without:123

Set Timesync Configured Sources = ON

When you change the debug level from 7 to 15, you might get the error message Unable to 
set Timesync Debug value, even when the debug level is successfully changed. You 
can ignore this message.

Changes in Timesync Default Configuration for Secondary Servers

When you add a second NetWare 6.5 server to a tree, the default Timesync configuration is as 
follows:

Timesync Configured Sources = ON

Timesync Time Sources = IP address of the master replica of the tree:123
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46 Tomcat Servlet Container on NetWare

Debug Mode Is Now Available

Debug mode is now available on Tomcat. Enter tc4jpda at the system console to start Tomcat 
in Java Platform Debugging Architecture (JPDA) mode, which uses port 9070 for debugging. You 
can use any JPDA-enabled Java debugger to debug Tomcat operations.

Broken Links in the Tomcat Web Application Manager

In the Tomcat Web application manager utility (http://domain_name/tomcat/htmlmanager/html/), 
some hypertext links to various Web applications might not work. This is because while the 
manager utility can identify the names of each installed application, it has no method for 
discovering the exact paths (including port numbers) to all of the applications on your server. In 
addition, Apache requires a trailing forward slash (/) at the end of its URL, which the manager 
utility does not append by default.

In most cases, this issue can be resolved by adding a forward slash (/) at the end of the URL. For 
example, if you clicked the /tomcat/manager link, the referenced URL might be

https://tycoon.provo.novell.com/tomcat/manager

Because this URL is missing a required trailing forwards slash, the browser returns an Object Not 
Found error message. You could then append a forward slash to the end of the URL to access the 
application:

https://tycoon.provo.novell.com/tomcat/manager/

If the trailing slash does not fix the issue, you can access the application some other way, such as 
through the NetWare® 6.5 Welcome Web site, or through Virtual Office, if you have installed it. 
For more information about available administration utilities, see the NetWare 6.5 Administration 
Overview.

Server Certificate Issues

Tomcat sometimes fails to start if there are problems with the server certificate.

If the server certificate has changed since the time of installation, you might need to export the SSL 
CertificateIP object to sys:/public/RootCert.der using ConsoleOne® and then execute the 
following command at the system console:

keytool -import -v -noprompt -trustcacerts -file sys:/public/
RootCert.der -keystore sys:/adminsrv/conf/.keystore -storepass 
changeit
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Tomcat Documentation

Refer to the Tomcat Administration Guide for NetWare 6.5 for information about using Tomcat on 
NetWare 6.5. For the official Tomcat documentation that is created and maintained by the Apache 
Foundation’s Jakarta Project, refer to the Tomcat 4.x documentation Web page (http://
jakarta.apache.org/tomcat/tomcat-4.0-doc/index.html).
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47 Virtual Office

Special Characters Might Cause Errors in Virtual Office

Using special characters, such as an ampersand (&), when creating a virtual team might cause a 
500 error. If this occurs, back out of the error screen and use a different character.

Lotus Notes E-mail Link Does Not Function in Netscape

This is an issue with Netscape and will be fixed in a future release.

Webmail Might Copy the Virtual Office Main Page after Entering Credentials

If this occurs, close the window and click the link again. Webmail should open.

eGuide Users Cannot Change Their Own Information without Rights

Administrators need to grant the users rights to the container.
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48 WAN Connectivity

Modem autodetection is currently not supported.
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